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Disclaimer
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1 A Guide to the Notes

These notes contain the information for:
(a) Installing the release version of 12d Model
12d Model needs to be installed on each computer it is going to run on.

For notes on installing 712d Model for the first time, or on a computer that is already running
12d Model, go to 2 Installing 12d Model 14 Release Version on page 6

(b) Setting up a Network CodeMeter

By default when 72d Model is installed it is set up for users with a Local (single user or
stand alone) CodeMeter that only allows 72d Model to be run on the computer with the
Local CodeMeter attached to it. With a Local CodeMeter, if 12d Model is to be run on
another computer with that Local CodeMeter then the Local CodeMeter must be moved to
the new computer. And 72d Model will stop running on the computer that no longer has the
Local CodeMeter attached to it.

To allow 72d Model to run on a number of computers without having to move a CodeMeter
to different computers, a NETWORK CodeMeter is used.

// 12d Local CodeMeter also referred to as a \ éd Network CodeMeter\\

Single User or Standalone CodeMeter
Silver USB
Stubby USB Long USB
with end cap without end f-. ]
Micro SD and ring cap and ring L f'?‘*
B {f,}
¥ & J
& 2 &«

& Note: the end cap and ring are cosmetic only / K /J

For notes on setting up a Network CodeMeter, go to 9 Network CodeMeters on page 59
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2 Installing 12d Model 14 Release Version

2.1 Requirements for Installing & Running12d Model 14

Before Installing and running 72d Model 14, you need the following:

(a) You must have Administrator privileges to install 72d Model
(a) Approximately 2 Gigabytes of disc space is required for the installation to succeed.
(b) A 12d Model CodeMeter or Wibu Lock for your computer

If 12d Model 14 is already running on your computer, the CodeMeter (or Wibu) lock you
already have will work with the new version of 12d Model 14 once you have a nodes file for
12d Model 14.

If 12d Model has NOT been running on your computer then DO NOT ATTACH THE LOCK
TO YOUR COMPUTER until after the CodeMeter/Wibu drivers have been installed as part
of the installation procedure.

(c) An email with the 72d Model 14 authorization file nodes.12d14n attached, or a folder with
the 712d Model 14 authorization file nodes.12d14n or nodes.4d in it.

(d) This document which has the internet links to the required executables and files
(e) Access to the internet to download the required executables and files

Please check that you have all the above items before commencing the installation.

Also note that:
(a) 12d Model 14 will not install on Windows XP or Windows Vista.

(b) 12d Model 14 will not run with the Hardlock locks which were used for 72d Model 10 and
earlier versions.

If you have a 12d Hardlock lock, please contact your 12d Model Reseller to obtain a
replacement CodeMeter lock.

(c) 12d Field will only run on CodeMeter locks

If you are running 72d Field and have a 12d Wibu or 12d Hardlock lock, please contact
your 12d Model Reseller to obtain a replacement CodeMeter.

(d) A three-button mouse is essential to efficiently use 72d Model on the desktop.

2.2 64 bit or 32 bit Version of 12d Model?

Microsoft has a 64 bit Windows and a 32 bit Windows operating system and so there are both 64
bit and 32 bit versions of 12d Model.

In 64 bit Windows, Microsoft has allowed for both 32 bit and 64 bit versions of the same software
to coexist on the same computer, so you could install both the 32 bit and the 64 bit version of
12d Model.

The 64 bit 72d Model only runs on 64 bit Windows and supports any of the 12d Model point
sizes from 5K through to 5M and Bigfoot.

The 32 bit 72d Model runs on both 32 bit and 64 bit Windows and only supports the 12d Model
point sizes from 5K through to 5M. That is, all point sizes except Bigfoot

So to run 72d Model Bigfoot, you must run 64 bit 72d Model on 64 bit Windows.



Chapter 2 Installing 12d Model 14 Release Version

2.3 Quick or Detailed Installation Notes

For abbreviated instructions and links for Installing the Release Version of 712d Model, go to 3
Quick Installation Notes for 12d Model 14 on page 8.

For detailed instructions and links for Installing the Release Version of 712d Model, go to 4_
Detailed Notes for Installing 12d Model on page 14.
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3 Quick Installation Notes for 12d Model 14

This chapter contains abbreviated notes for Installing 72d Model 14, and the links to download
all the files required for the installation.

For more detailed notes on installing 12d Model, see 4 Detailed Notes for Installing 12d Model
on page 14.

Important Note: 12d Model 14 will not install on Windows XP or Vista.

3.1 Installing and Uninstalling

(a) You need to be Administrator to install 72d Model 14 and CodeMeter and/or Wibu drivers

(b) You can have earlier versions of 712d Model, both 64-bit and a 32-bit, on your computer at
the same time as 72d Model 14.

(c) You can have both a 64-bit and a 32-bit 72d Model 14 on your computer at the same time.

(d) A new 72d Model 14 64/32 can't be installed if there is already a matching 72d Model 14
64/32 on your computer.

The 12d Model 14 Installer will check for an existing matching 72d Model 14 64/32 and if
one exists, displays the version number and asks if you want to Uninstall it.

If you say No then the 72d Model 14 Install will terminate.
Important Note

The Uninstaller deletes everything in the 712d\712dmodel\14.00 folder in Program Files (or
in Program Files (x86) for a 32-bit Install on a 64-bit O/S) so do not modify any of those
files.

Any modification that you make to these files must go into User or User_Lib.

(e) The Uninstaller will not delete any of the training material loaded into the folders
12d\14.0\training and 12d\14.0\courses.

The 12d Model 14 Installer (32 bit and 64 bit) will overwrite any files of the same name in
those folders.

(f) Do not attach the CodeMeter or Wibu locks before installing the drivers

The 12d CodeMeter or 12d Wibu locks (dongles) must NOT be attached to the computer
before the CodeMeter/Wibu drivers are installed (see 3.5 Certifying CodeMeters on page 9).

3.2 Hardware Locks (Dongles) Supported

a) The brand Hardlock locks can not be used for 12d Model 14.

(
(b) 12d Field is only available in 12d Model 14 for CodeMeters.
(c) Network CodeMeters only support 712d Model 11 and above.
(d) The older Wibu locks (non-CodeMeter) are supported for 12d Model 14 but are being
phased out.
Page 8 Installing and Uninstalling
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3.3 CodeMeter and Wibu Drivers

If you are using a CodeMeter for the first time on this computer, then you will need to install the
CodeMeter drivers.

If you are using a Wibu for the first time on this computer, then you will need to install the Wibu
drivers. If you already have Wibu, the drivers need to be Wibu 6.1 or above.

CodeMeter and/or Wibu drivers can be installed with:

https://downloads.12dmodel.com/v14/12d_Model 14 _C2m/12d_lock_drivers Install_16_Aug_19.exe

3.4 12d Model Installs for Windows 7, 8.1 and 10

(a) 12d Model Install for 64 bit Window 7, 8.1 and 10 - approximately 1 Gb
https://downloads.12dmodel.com/v14/12d_Model_14_C2m/12d_Model_14_C2m_64_ Setup.exe

(b) 12d Model Install for 32 bit Windows 7, 8.1 and 10 - approximately 900 Mb
To download the 32-bit Install click on the link

https://downloads.12dmodel.com/v14/12d_Model 14 C2m/12d _Model 14 C2m_32_ Setup.exe

3.5 Certifying CodeMeters

A CodeMeter needs to be Certified over the Internet every two months. So you need to have
access to the Internet for the first time you start up 72d Model with a CodeMeter and then at lest
every two months.

Once 712d Model is installed, there is an environment variable AUTO_CERTIFY_DONGLE_4D
that can set so that 72d Model automatically certifies the CodeMeter when required.

See 5 Certifying CodeMeters on page 42.

Please contact your 72d Model Reseller if you have any problems Certifying CodeMeters.
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3.6 For Users with 12d Model 14 Already Installed

3.6.1 Setting Up Your User Folder for 12d Model 14

The folder User contains the files that you have modified to replace those that 72d Model installs
in the folder Set_ups. For example, your own names.4d or linestyl.4d.

So if you have files in your User folder in 12d Model 14, you will probably also want to use many
of them with 712d Model 14.

In 12d Model 14, the default place for User is ¢:\12d\14.00\User but it could also be pointed to
by the environment variable USER_4D.

For 12d Model 14, you need to create a new User folder and copy to it any files from the
12d Model 14 User folder that you want to use with 712d Model 14. You may need to copy the
whole of the 712d Model 14 User folder to the new area.

The default location for the 72d Model 14 User folder is c:\12d\14.00\User but if the
environment variable USER_4D was used to point to a different location for the User folder in
12d Model 14 then you will probably want to use a non-standard User folder for 72d Model 14. If
that is the case then you will need to change USER_4D in the env.4d file for 12d Model 14 to
point to your User folder for 12d Model 14.

3.6.2 Setting Up Your User Lib Folder for 12d Model 14

The folder User_Lib contains your own library files and if you had files in a User_Lib folder in
12d Model 14, you will probably also want to use many of them with 72d Model 14.

In 12d Model 14, the default place for User_Lib is ¢:\12d\14.00\User_Lib but it could also be
pointed to by the environment variable USER_LIB_4D.

For 12d Model 14, you need to create a new User_Lib folder and copy to it any files from the
12d Model 14 User_Lib folder that you want to use with 12d Model 14. You may need to copy
the whole of the 72d Model 14 User_Lib folder to the new area.

The default location for the 712d Model 14 User_Lib folder is ¢:\12d\14.00\User_Lib but if the
environment variable USER_LIB_4D was used to point to a different location for the User_Lib
folder in 12d Model 14 then you will probably want to use a non-standard User_Lib folder for
12d Model 14. If that is the case then you will need to change USER_LIB_4D in the env.4d file
for 12d Model 14 to point to your User_Lib folder for 12d Model 14.

3.6.3 Setting Up Your env.4d File for 12d Model 14

The file env.4d contains environment variables that are used to customise 72d Model.

An env.4d file is installed it the Set_Ups folder when 2d Model is installed and if a user wants to
make any modifications to any of the environment variables in env.4d, then the modified env.4d
file is placed in the User folder.

So if you have an env.4d file in your User folder in 712d Model 14, you will probably also want to
use it 72d Model 14.

The default location for your modified env.4d file in 12d Model 14 is in your User folder for
12d Model 14 so for 12d Model 14, you need to copy this env.4d file to your User folder in
12d Model 14.
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3.6.4 Are You Using a 12d Network Lock?

If you are using a 12d Network Lock (CodeMeter or Wibu) for 12d Model 14, then the file
dongles.4d which is in the User folder contains the information to tell 72d Model that it has to
search for a network lock, and possibly which computer the network lock is on.

So if you are using a 12d Network Lock for 12d Model 14, you will need to copy your
12d Model 14 dongles.4d file to the 712d Model 14 User folder.
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3.7 Network CodeMeters

3.7.1 Using a 12d Network CodeMeter for the First Time

If you are setting up 72d Model to use a 12d Network CodeMeter for the first time, please read
the section 9 Network CodeMeters on page 59.

3.7.2 Updating Licenses in a Network CodeMeter

If you are modifying the virtual 712d Model dongle within a Network CodeMeter (for example
increasing the number of licenses), go to section 10.5 Updating Licenses in Network
CodeMeters on page 116.
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3.8 Documentation and What’s New

The links for downloading documentation on 72d Model are given in 6 Documentation on
page 47.

The links for downloading documentation, power points and videos on what is new in
12d Model 14 are given in 7 What's New in 12d Model 14 on page 55.

This ends the Quick Installation notes for 72d Model 14.

The rest of the Chapters in this document are:

4 Detailed Notes for Installing 12d Model on page 14

5 Certifying CodeMeters on page 42

6 Documentation on page 47
7 What's New in 12d Model 14 on page 55

8 Errors Installing and Authorising on page 56

9 Network CodeMeters on page 59
10 CodeMeter Control Center & WebAdmin on page 84
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4 Detailed Notes for Installing 12d Model

These are the complete notes are for installing the Release version of 12d Model 14.

A. Disk Space required for installing 72d Model 14
Approximately 2 Gigabytes of disc space will be required for the installation to succeed.
Before installing 72d Model, it is best to reboot the computer.

Your login must have Administrator privileges.

B. Do not attach the 12d Model locks before installing dongle drivers

The 12d CodeMeter or 12d Wibu locks must NOT be attached to the computer before the
CodeMeter/Wibu drivers are installed in Step 1.

C. Installing

The following Steps 1 to 4 will take you through the Installation of CodeMeter and/or Wibu
drivers, the installation of 12d Model and the setting up of the nodes.4d file.
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Step 1.

Install the CodeMeter or Older Wibu Drivers
WARNING You need to have System Administrator rights to install the CodeMeter/Wibu drivers

The first step is to install the CodeMeter/Wibu drivers using 12d_dongles_installation _date.exe
which is downloaded from:

https://downloads.12dmodel.com/v14/12d_Model 14 _C2m/12d_lock_drivers Install_16_Aug_19.exe

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

Once you have downloaded 12d_hardware lock_drivers_installation_date.exe, click on it to
begin the installation process.

The Install which dongle drivers? panel will appear.

‘r.l Install which hardware lock drivers? - =

Which hardware lock drivers would you like to install?

Codemeter </<Tick on CodeMeter)
] Wibu

Imstall Cancel

If you are using a CodeMeter for the first time on this computer, then you will need to install the
CodeMeter drivers.

If you are using a Wibu for the first time on this computer, then you will need to install the Wibu
drivers. If you already have Wibu, the drivers need to be Wibu 6.1 or above.

Note that If you only using CodeMeters (variety of colours and sizes) then you only need to
install the drivers for CodeMeters.

a

N

Micro SD

12d Local CodeMeter also referred to as a \ ﬁZd Network CodeMeteN
Single User or Standalone CodeMeter

Silver USB

Stubby USB Long USB

with end cap
and ring

without end A
cap and ring ol s

- a il

Note: the end cap and ring are cosmetic only j K

Y

Note: for a Stubby USB, the end cap and ring are cosmetic only and can be pulled off to
make it into a Stubby USB without the end cap and ring. This does not affect the
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performance of the Stubby USB.

older Wibu Network

older Wibu Standalone

If you have both CodeMeter and the older Wibu dongles then both sets of drivers must be
installed.

(a) If you have only CodeMeter ticked on then clicking on Install will install the CodeMeter
drivers.

Go to _nstalling the CodeMeter Drivers: on page 17

(b) If you have only Wibu ticked on then clicking on Install will install the Wibu drivers.
Go to _nstalling the Wibu Drivers: on page 21.

(c) If you have both CodeMeter and Wibu and ticked on then clicking on Install will first install
the Wibu drivers and then continue on to installing the CodeMeter drivers.

Go to _Installing the Wibu Drivers: on page 21
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Installing the CodeMeter Drivers:

The script to install the CodeMeter drivers begins.

CodeMeter Setup CodeMeter Runtime Kit Setup

15 CodeMeter Runtime Kit v5.80 Setup - X

Welcome to the CodeMeter Runtime Kit
v6.80 Setup Wizard

This will install CodeMeter Runtime Kit 6,80 on your
computer. Click Mext to continue or Cancel to exit the Setup
Wizard.

C.d _/..‘/' :

Build 3312

Back Cancel

Select Next to continue
End-User License Agreement CodeMeter Runtime Kit Setup

17 CodeMeter Runtime Kit v5.80 Setup - X

End-User License Agreement

Please read the following license agreement carefully

WIBU-SYSTEMS AG, Karlsruhe, Germany and Wibu-Systems USA Inec., ~
Edmonds, WA, USA

Software License Agreement, Single Use License

CodeMeter and WibuKey Software

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT ({"LICENSE™)
BEFORE USING THE SOFTWARE. BY USING THE SOFTWARE, YOU

ARE AGREFING TO BE BOUND BY THE TERMS OF THIS LICENSE. IF

YOU ARE ACCESSING THE SOFTWARE FLECTRONICALLY, SIGNIFY
YOUR AGREEMENT TO BE BOUND BY THE TERMS OF THIS LICENSE

BY CLICKING THE "AGREE/ACCEPT" BUTTON. IF YOU DO NOT AGREE
TO THE TERMS OF THIS LICENSE. RETURN THE WIBU-SYSTEMS h

CI accept the terms in the License AgreemenD

Print Back Cancel

Read the License Agreement and if you are happy with it,
tick "l accept the terms in the License Agreement" and then select Next to continue
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Installation Scope CodeMeter Runtime Kit Setup

#7 CodeMeter Runtime Kit v6.80 Setup - *

Installation Scope
Choose the installation scope and folder

User name: ||jg
Organization: Design Without Pain

() Install just for you (candice.admin)

CodeMeter Runtime Kit v6.80 will be installed in & per-user folder and be available
just for your user account.

(@) Install for all users of this machine

CodeMeter Runtime Kit v&6.80 will be installed in a per-machine folder by default
and be available for all users. You must have local Administrator privileges.,

Enter your User name and Organisation.

Click on either Install just for you or Install for all users of this machine
and then select Next to continue

Custom Setup CodeMeter Runtime Kit Setup

#7 CodeMeter Runtime Kit v6.80 Setup - *

Custom Setup
Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

This features installs the CodeMeter
- = = | WibuShellExtensior Runtime Kit on your computer,

- (=l ~ | User Help

This feature requires 2/MB on your hard
drive. It has 2 of 2 subfeatures selected.
The subfeatures require 17MB on your
hard drive.

Browse...

Reset Disk Usage Back Cancel

Select Next to continue
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Ready to Install CodeMeter Runtime Kit Setup

17 CodeMeter Runtime Kit v5.80 Setup - X

Ready to install CodeMeter Runtime Kit v6.80

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back Install Cancel

Select Install to continue

Installing CodeMeter Runtime Kit Setup

17 CodeMeter Runtime Kit v5.80 Setup - X

Installing CodeMeter Runtime Kit v6.80

Please wait while the Setup Wizard installs CodeMeter Runtime Kit v&.80.

Status: Publishing product information
|
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Completed CodeMeter Runtime Kit Setup

#7 CodeMeter Runtime Kit v6.80 Setup - *

Completed the CodeMeter Runtime Kit
v6.80 Setup Wizard

Click the Finish button to exit the Setup Wizard.

Build 3312

Back Cancel

Select Finish to end

The CodeMeter dongle drivers have now been installed and the 12d Model Dongle Setup
screen will appear.

)

12d Model Dongle Setup [ 22 |

click OK

Note: A CodeMeter icon, that is used to bring up the CodeMeter Control Center, is also installed
on your task bar.

If you were installing the CodeMeter drivers as part of setting up a Network CodeMeter, go to _
What is Done to the Computer By Step 1.

Otherwise continue to Step 2. Attach the Dongle.
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Installing the Wibu Drivers:

The script to install the old Wibu dongle drivers begins.

WIBU-KEY Setup Welcome to WIBU-KEY Software Setup

48} WibuKey Setup =] = |

Welcome ta the Wibuk.ey Software Setup program. This
progran will instal ‘wibuk.ey Software on your computer.

control panel] before running this Setup progran.

URNing.
Click zMests to continue with the Setup program.

It iz strangly recommended that you exit all Windows programs [and the

Click zCancels to quit Setup and then cloze any programs you hawe

Yerzion 6. 20

Cancel |

select Next to continue

WIBU-KEY Setup Language Selection

(48 WibuKey Setup ===

"

Fleaze zelect the languages that ‘wibuk.ey should support:

[¥ Englizh

[ Chinese (Simplified)
[ French

[~ Gemnan

[ ltalian

[ Hungarian

[~ Japarese

[~ Portuguese

[~ Spanish

< Back Meut » Cancel

tick your language and then select Next to continue
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WIBU-KEY Setup Installation folder

'~ WIBU-KEY Setup _ ol x|

Setup will install the *IBL-KEY Tools in the following folder,

To install to this folder, click sMexts
Toinstall to a different folder, click sBrowzes and zelect
another folder.

Y'ou can choose not to install the WIBL-EEY tools by clicking
s=Cancels to exit Setup.

C:4%Program Files'WBLUEKEY Browse. |

" Destination Folder

select Next to continue

WIBU-KEY Setup Installation folder doesn'’t exist

setp

\“!) The specified folder does not exist.
Should Setup create the folder?

Yes | No |

click Yes to continue

WIBU-KEY Setup Component Selection
(48 WibuKey Setup (o] =3 |[=]

Select the Wibuk.ey components you like to install:

"

[ 32 bit wWhkM etk LAM Metwork, Server

[ Install as NT service with autostart

[ kLA Al et Matwark Manitar [32 bit)

Once you have selected the components pou wish ta ingtal,
press the sMexts button to complete the installation.

< Back Meut » Cancel
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For a standard install, nothing needs to be ticked on (the WibuKey components are for
monitoring a Wibu network dongle).

make sure nothing is ticked and then select Next to continue

WIBU-KEY Setup

Tasks to be Performed

42 WibuKey Setup

(=& =]

i

If you prezs =Mexts the following tazks will be performed:

Operating spstem: Windows 7 -~
Source path; C:hUzerstlighdppD atatLocahTemp'WZSE3 THMP

Selected langquages:
Englizh

The following components will be inztalled:

wibuk.ey driver files

WWibukey COM control

WWBLU-SYSTEMS MwinBd/ =64 variant] Shell Extenzion

< Back Meut » Cancel

select Next to continue

WIBU-KEY Setup

Tasks done

8 WibuKey Setup

(=@ ][==]

If you press =M exts the following tazks will be performed:

Selected languages: -
Englizh

The following components will be installed: —
wibukey driver files

wibuley COM control

WIBLU-SYSTEMS MwinG4/u64 variant] Shell Extension

Copying files ... done.

“Werifying language modules ... done.
Installing files .. done.

erifying installed language modules ... done.
Storing uninztall information ... done.
Creating shortcuts ... done.

Tranzfering settings ... done.

m

1

< Back Mest » Cancel

"

select Next to continue
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WIBU-KEY Setup Setup Complete

#8 WibuKey Setup

=)= [=]

Wibukey Software Setup is complete.
Setup can launch the Readme help file with the latest product

informations.

[ *Yes. | want to view the Beadme text now.

Click. #Finizh« to complete Setup.

Finish |

leave Yes, | want to view the Readme text now unticked and select Finish

Setup OK Setup OK
rSetup @‘
@ WibuKey driver successfully installed.
oK |
click OK

The WIBU dongle drivers have now been installed
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If both CodeMeter and Wibu were ticked on then the installation of the CodeMeter drivers will
then begin. See _nstalling the CodeMeter Drivers: on page 17,

Otherwise the 12d Model Dongle Setup screen will appear.

)

12d Model Dongle Setup | £3 |

| Installation complete!

click OK

Continue to Step 2. Attach the Dongle on page 26.
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Step 2.  Attach the Dongle

The 12d Model dongle (CodeMeter or old Wibu) can now be attached to the computer.
For USB dongles:

Warning: you must have System Administration rights the first time you
attach a USB dongle to any USB port:

When a USB dongle is attached for the first time to any USB port, Windows will detect that it
is new hardware and needs to load the dongle drivers for that USB port - this will require
System Administration rights.

Since the dongle drivers have already been loaded onto your computer, when the USB
dongle is attached to a new USB port, it will be recognised as new hardware

Found Mew Hardware

WIBL-BO=/RL

and Windows should automatically install the correct dongle driver.

Found Mew Hardwar

\> WIBL-BO=/RU

Inztalling ...

IMPORTANT NOTE IF THE WIBU DONGLE IS NOT RECOGNISED:

If the WIBU dongle is not recognised and you get the Found New Hardware screen
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Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will search for current and updated software by looking
on your computer, on the hardware installation CD, or on the
Windows Update Web site (with your permission).

Read our privacy policy

Can Windows connect to Windows Update to search for
software?

(" Yes, this time only
(" Yes, now and every time | connect a device
(" No, not this time

Click Next to continue.

= Back [{ext = | Cancel |

please go to the section on how to find the Wibu drivers

NOTE - even though your dongle is working on one USB port, if you try and attach the dongle
to a new USB port, the dongle drivers will need to be installed for the new USB port. You will
need System Administration rights to install the dongle drivers on the new USB port.

The dongle must be attached to the USB port at all times, otherwise 12d Model will stop
running.

SPECIAL NOTE ON CERTIFYING CODEMETERS

The 12d CodeMeters must communicate over the Internet with a Wibu Time Server every two
months to check that there is no problem with the CodeMeter that your 12d Model license is
using. This is called Certifying the CodeMeter.

For Certification to occur, a computer that can access the CodeMeter must also have access to
the Internet to run the Certification.

One month before the end of the two month period, 72d Model brings up the
Certify CodeMeter Dongle panel which gives the number of days, minutes and seconds remaining
until Certification is required.

If you area using a new CodeMeter from your 712d Model Reseller, then it will usually come
already Certified.

For more information on Certifying, see 5 Certifying CodeMeters on page 42.

Continue to Step 3. Installing 12d Model 14 Release Version on page 28.
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Step 3.  Installing 12d Model 14 Release Version

The installer for 12d Model 14 is downloaded from the internet.

(a) Installing 12d Model from the Download Files:

To Run 12d Model 14 on 64 bit Windows:

If you are running 72d Model on 64 bit Windows, then you need to download the
12d Model 64 bit installer which installs a 64-bit 712d.exe.

To download the installer, click on
https://downloads.12dmodel.com/v14/12d_Model 14 C2m/12d_Model 14 C2m_64 Setup.exe

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

When running 12d Model 14 on 32 bit Windows:

If you are running 72d Model on 32 bit Windows, then you need to download the 72d Model
32 bit installer which installs a 32-bit 12d.exe.

To download the installer, click on
https://downloads.12dmodel.com/v14/12d_Model_14_C2m/12d_Model_14_C2m_32_Setup.exe

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Once the installer is downloaded, click on it (or run it) and the 712d Model installation begins.

You may get a message warning you about not being able to verify who created the file:

' ™
Open File - Security Warning &J

We cant verify who created this file. Are you sure you want to
run this file?

lﬂ Name: I\12d_cd\12\DVD\Setup'64\Release\Setup.exe
Type: Application
From: L\12d_cd1 2\DVD\Setup'64\Release\Setup.exe

Run ] [ Cancel

locations you don't recognize can ham your PC. Only run this file if

|Q| Thig file is in a location outside your local network. Files from
= you trust the location. What's the risk?

“ 4

Click on Run so that the installation can begin.

‘ﬂh 61% Preparing installer... @
Please wait while the instzller is prepared...

Cancel

Continue to_Installing 12d Model on page 29.
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Installing 12d Model

The 12d Model 14 installation starts by unpacking the information in the installation exe and then
the installation begins.

fﬂ_‘ 619 Preparing installer... @
Please wait while the installer is prepared...

Cancel

Note - the following screens are for the 64 bit install but the 32 bit install is identical except the
words 64 bit are replaced by 32 bit.

If a 12d Model 14 of the same bit type is already installed on your computer, it must be
uninstalled before the installation can proceed.

If the Installer detects this case, you will be asked if the Installer can uninstall the existing
version. Unless this is done, the installation can not proceed.

Note: The uninstall deletes everything in the 12d\12dmodel\14.00 folder in Program Files (or in
Program Files (x86) for a 32-bit Install on a 64-bit O/S) so you should never modify any of those
files.

12d Model 14 - 64 ki

@ Ancther version of this product (14.0 Alpha 14 [DEVELOP]TINT 10 Mar

| 17)is already installed!
Would you like to uninstall it now?

Click on Yes to continue.

You then receive a Warning that the files will be deleted.

12d Model 14 - 64 bit Installation

Warning! Proceeding with the uninstaller will delete all files
from your installation directory.
Are you sure you wish to continue?

Click on Yes to continue.

All the files in the 12d\12dmodel\14.00 folder in Program Files (or in Program Files (x86) for a
32-bit Install on a 64-bit O/S) will then be deleted, and the 12d Model xx entry removed from the
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Windows Registry.

The installation of the new 12d Model can now begin and the Welcome screen is displayed.

Welcome Welcome message

¥ 12d Model 14 - 64 bit Installation [E=R

Welcome to the 12d Model 14 - 64 bit Setup Wizard

s
‘Igﬂ

This wizard will guide you through the installation of 12d Model 14
- 64 bit.

It is recommended that you close all other applications before
starting Setup. This will make it possible to install without requiring
a system reboot.

[ Ned> ][ Cancel
Select Next to continue with the installation
Software License Agreement 12d Solutions license agreement
12d Model End User License Acceptance
Please read the terms and conditions of use for 12d Model. Installing this product is w_-
considered acceptance of this license.
12D Solutions Pty Ltd ~

Software License Agreement with Limited Warranty

Important - Read Carefully Before Installation and Use

This 15 a legal document and 1s an agreement between you {either an mdividual or an
entity) and 12D Solutions Pty Ltd. By opeming the sealed software package and/or by
usmg the SOFTWAEE, vou agree to be bound by the terms of this Agreement.

If vou do not agree to the terms of this Agreement, promptly return the disk package and
accompanying items (inchiding any hardware rtems, printed matenals and binders or other ,

~ A -

( | have read and accepted the terms of this Software License AgreemerD

Mext = Cancel

If you agree with the License conditions, tick on I have read and accept the terms of the
Software License Agreement.

Select Next to continue with the installation
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Select Components

afl 12d Model 14 - 84 bit Installation — x

Select components

Select the components pou would like to install m_

- 12d Model

zes and Training

“[ Trimble Precision Huwe

only tick Courses and Training if you want
the data files for the Getting Started manuals

only tick Trimble Precision Runtime if you want
to install Trimble Precision Runtime

¢ Back Mest » Cancel

Tick on 12d Model to install 12d Model.

Only tick on Courses and Training if you want to install the files for the Getting Started
manuals.

Select Next to continue with the installation

Installation Location

R}

Pick Installation Location

Select the location where you would like this application to be installed m.

Setup will install this application in the following folder. To install in a different
folder, click Browse and select another folder.

Installation location:  |C:\Program Files'12d"\12dmodel"14.00 Browse

Space required: 2.15GB

Space available: 70.61GB

< Back Next >

Continue with the default installation folder for the software:

for 64 bit version: c:\Program Files\12d\12dmodel\14.0

for 32 bit version: c:\Program Files (x86)\12d\12dmodel\14.0
or click on Browse to browse to another folder for the installation

Select Next to continue with the installation
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User Area
¥
Select User Area )
Select the path where your User and User Lib folders will reside m.
Target: |c:\12d\14.00 Browse

Continue with the default folder for the User Area for the software:

c:\12d\14.0

or click on Browse to browse to another folder for the User Area.

Select Next to continue with the installation

Ready to Install

afl, 12d Model 14 - 64 bit Installation —

Performing installation

Press Install to begin the installation.

< Back Install

Cancel

Select Install to begin the actual installation
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The software will be copied and installed onto the computer.

The Microsoft C++ Redistributables will be automatically installed (64 and 32 for 64-bit install)

W

Performing installation

Extracting adac_cadastre_attributes_panel 4do -
Extracting ADAC_Clean_Up chain

Extracting ADAC_Common_Editor_Panel 4do

Extracting ADAC_delete_attributes_panel 4do

Extracting ADAC_design_base.chain

Extracting ADAC_design_base_debug.chain

Extracting adac_enhancements_attributes_panel 4do
Extracting Adac_Example_Council_41_Definitions. 12duaf
Extracting Adac_find_strings_with_object|D_panel 4do
Extracting adac_global_attributes_panel 4do

Extracting ADAC _kerb_splitting_panel 4do

W

Performing installation

Extracting
Extracting
Extracting
Extracting
Extracting
Extracting
Extracting
Extracting
Extracting
Extracting
Extracting

#3 Microsoft Visual C++ 2012 Redistributable (<86) - 11.0.51106 Setup | = || & |23

Microsoft Visual C++ 2012
Redistributable (x86) - 11.0.51106

Setup Progress

Processing: Initializing...

Cancel

Setup Complete

End of the installation.

W

Installation for 12d Model 14 - 64 bit completed

R

12d Model 14 - 64 bit has been installed on your computer.

Click finish to close this setup wizard.

Select Finish to complete the installation

Documentation and What’s New Page 33
== = == = L 7z
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This completes the installation of the 12d Model software.

12d Model will not function without an authorisation file called nodes.4d.
The final step is to install and test the nodes file. Go to Step 4. Installing the Nodes.4d file on

page 35.

The folders and icons that are created in the installation are given in the sections:
4.1 Folders Created by the Installation on page 38

4.2 Icons Created by the Installation on page 40,

Continue to Step 4. Installing the Nodes.4d file on page 35.
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Step 4. Installing the Nodes.4d file
12d Model will not create new projects or open an existing project without an authorisation file
called nodes.4d with valid information in it.
The information inside nodes.4d controls
(a) which 12d dongles are authorised to run 72d Model
(b) what version of 12d Model will run for a dongle
(c) what modules are authorised to run for a particular 12d dongle

To authorise 72d Model to run with your 12d dongles, a file called nodes.12dxxn where xx is
the 12d Model version number, will have been emailed to you by your local 712d Model Reseller.

For example, for 12d Model 11 the file will be called nodes.12d11n

Subject: 12D Auth file for 12D Solutions - Lee; Product 12d Model - 5c2d47013c -

Attachments: |3 nodes. 12d11n (11KE)

MNodes file for : 12D Solutions - Lee
- 5¢2d47013c -

The authorization file for 12d Model - is attached to this message.

The self-install procedure which follows is for this one workstation and requires 12dmodel installed.
After 12d Model version 11 is installed, please double click on the file attachment [nodes.12d11n] & to open it and 12d will guide you through.

If this succeeds you do not need to read further.

If this does not work it may be that the mail programme does not allow you to run attachments.
In this case, simply save the attached file to your desktop and open (from the right-mouse menu or by double-click).
This will start the installation for the nodes file.

Instructions for manual Installation:
For version 11 of 12d Model, usually goes in the folder
"™12d\11.00" and once there it must be renamed to "nodes.4d"

Codemeter dongles require a driver installation which can be obtained here
http://www.wibu.com/en/downloads-user-software.html

If the product is still not authorized after replacing or updating "nodes.4d"
please contact 12D Solutions on (61)(02) 9970 7117 or email support@12d.com

Installing 72d Model xx on a computer sets up a Windows file association so that a
nodes.12dxxn file is recognised and brings up the Install a 12d Model xx Nodes File panel which
is used is to install a nodes.4d file in the correct location.

In the email, double click on the files nodes.72dxxn and the Opening Mail Attachment panel
comes up.
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Subject: 12D Auth file for 12D Solutions - Lee; Product 12d Model - 5c2d47013c -
Attachments: |3 nodes. 12d11n (11KE)

MNodes file for : 12D Solutions - Lee
- 5¢2d47013c -

The authorization file for 12d Model - is attached to this message.

i '
The self-install procedure which follows is for this Dpening Mail Attachment P4
After 12d Model version 11 is installed, please dou

If this succeeds you do not need to read further.

- || You should only open attachments from a trustworthy source.

Attachment: nodes. 12d11n from 12D Auth file for 12D

Solutions - Lee; Product 12d Model - 5c2d47013c - -
If this does not work it may be that the mail progra Message (HTML)

In this case, simply save the attached file to your d
This will start the installation for the nodes file.

click on
Open

Instructions for manual Installatio

For version 11 of 12d Model, usually goes in the fo \* Open ] [ Save

"™12d\11.00" and once there it must be renamed t

Would you like to open the file or save it to your computer?

Always ask before opening this type of file

L. -
Codemeter dongles require a driver installation which can be obtained here
http://www.wibu.com/en/downloads-user-software.html
If the product is still not authorized after replacing or updating "nodes.4d"
please contact 12D Solutions on (61)(02) 9970 7117 or email support@12d.com

Click on Open and then the Install a 72d Model xx Nodes File panel appears

8 Install a 12d Medel 12 Nodes File - >

Install Manage

Source: |C MUsers'fred doofungles'App Data"'-.LDI:aI"-.Micmsnﬂ"-.‘.".n'induws"'| 3

Operation: Prepend b

Destination: ||: 412d412. 00 nodes 4d | =
Ins I Cancel

The choices for Operation are:

Prepend - if a nodes.4d file already exists, the information in the nodes.12d14n file is added

to the beginning of the existing nodes file. A backup up copy of the existing nodes.4d is
created.

Replace - if a nodes.4d file already exists, it is replaced by a new nodes.4d file with the
information in the nodes.12dxxn file in the new nodes file. A backup copy of the existing
nodes.4d is created.

Append - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added
to the end of the existing nodes file. A backup copy of the existing nodes.4d is created.

Select Replace, Append or Prepend and then click Install.
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The new/updated nodes.4d file is created in the Destination folder (default is C:1712d\xx.00) and
if a nodes.4d file already existed, a backup copy of it is made.

12d Modes Installer hod

Modes update completed!
Old nodes backed up to: \12d\12.000nodes.5.4d

OK

ﬂlote - if you don’t have the file nodes.12dxxn attached to an email but instead have the file in a \

.

folder accessible from your computer, then you can do the following:

If there is a nodes.12dxxn file, double click on that file and the Install a 12d Model Nodes File panel
should appear and you continue as per the instructions above.

If that doesn’t work, start up 72d Model xx and click on the Nodes.4d button at the bottom of the
Open a Recent Project panel. This will also bring up the Install a 12d Model Nodes File panel and you
can browse for the nodes.12dxxn file in the Source panel field. You can then continue as per the
instructions above.

/

CONGRATULATIONS - 12d Model has now been successfully installed.

If 12d Model did not install correctly and an Authorization Error panel came up, go to the
section, 8 Errors Installing and Authorising on page 56, of these notes.

To obtain documentation for 72d Model, go to 6 Documentation on page 47.

Expanded Important Note on Nodes.712d14n and Nodes.4d
The 12d Model 14 nodes.12d14n file will normally be emailed to you.

During the installation of 12d Model 14, an association is created for files ending in .72d14n so
after the installation, opening the nodes.12d14n on the email will bring up the Install a 12d
Model Nodes File program which can copy the information in the nodes.12d14n file to the
required area (normally C:\72d\14.00) and nodes.4d file.

If you do not have the nodes.12d14n attached to an email but instead have it in a folder and
have installed 12d Model 14, double clicking on the nodes.12d14n file will also bring up the
Install a 12d Model Nodes File program which can copy the information in the nodes.12d14n
file to the required area (normally C:\712d\74.00) and nodes.4d file.

Or if the 12d Model 14 icon is clicked on, the Open a Recent Project panel comes up and clicking
on the Nodes button will also bring up the Install a 12d Model Nodes File program which can
copy the information in the nodes. 12d14n file to the required area (normally C:\12d\14.00) and
nodes.4d file

Please do not change the name of the created nodes.4d file. 12d Model will only search for an
authorization file called nodes.4d.

Documentation and What’s New Page 37
e = = = > <= 7 —Z
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4.1 Folders Created by the Installation

(a) For 64 bit 12d Model on Windows 64 bit operating systems:
The 12d Model installation loads the 712d Model software into the folder
C:\Program Files\12d\12dmodel\14.00
OR

(b) For 32 bit 72d Model on Windows 32 bit operating systems
The 12d Model installation loads the 12d Model software into the folder
C:\Program Files\12d\12dmodel\14.00
OR

(c) For 32 bit 712d Model 32 bit (for versions up to 5M) on Windows 64 bit operating systems:
The 12d Model installation loads the 12d Model software into the folder
C:\Program Files (x86)\12d\12dmodel\14.00

12d Model users normally only have read access to the Program Files and/or Program Files
(x86) folders.

Local Disk (C:) » Program Files » 12d » 12dmodel » 14.00

Mame

12dfield
12dmodel
autocad
dda
dda_2d
dws
e57
e 12d Model software area under Program Files
faro

fhxtol2da

fop-1.0

graphviewer

help

imagel2d

impert

landxml

leica

library

macros

nt.x64

pdf

pdf3dwriter

pdftel2da

print

public

set_ups

tools

topcon

trimble

wintileprint

xm

2, uninstaller.exe
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The 12d Model installation on either 32 bit or 64 bit Windows, also creates an area
C:\12d\14.00

which during the installation is given read/write access for the user.

If the Courses and Training component was ticked, then the installation will place the training

data used with the Getting Started for Design and Getting Started for Surveying manual in the
folder 12d\14.00 (or the folder you selected)

Local Disk (C:) » 12d » 1400 = training

Mame

design

sUrvey

12d Model user areas

o /

The folder 12d\14.00 is also the default folder where the nodes.4d file will be installed, and is
also the default area where a user creates their own subfolders User and User_Lib for their user
configurations of 12d Model.

Warning

An Uninstall will NOT delete any of the training material loaded into 12d\14.0\training and
12d\14.0\courses by a previous installation.

The 12d Model 14 Install (32 bit and 64 bit) will overwrite any files of the same name in these
areas.
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4.2 Icons Created by the Installation

The installation loads the appropriate components and creates the 72d Model 14 icon

12d Model 14
- 32 Bit

icon for 12d Model 32 bit exe

icon for 12d Model 64 bit exe

The 12d Model 14 - 64 and 12d Model 14 - 32 icons fire up 12d Model and attach to the folder
12d\14.00.

4.3 Copying Existing User, User Lib and env.4d

If you have 12d Model 12 installed on your computer, then you will probably want the files in the
folders User and User_Lib, and env.4d to be used for 712d Model 14.

(@)

The folder User contains your files that are to replace those that 12d Model installs in
Set _ups (e.g. names.4d, linestyl.4d) and if you already have some, you will probably also
want to use them for 12d Model 14.

For 12d Model 12, the default place for User is ¢:\72d\112.00\User but it could also be
pointed to by the environment variable USER_4D.

If there is an existing User folder, you need to create a new User folder for 12d Model 14
and copy to it any files that you want for 12d Model 14.

The default place for the new User in 12d Model 14 is ¢:\12d\14.00\User but if USER _4D in
your V12 env.4d was used to point to your V12 User then you will need to change
USER_4D in your V14 env.4d to point to your V14 User folder

You may need to copy the whole of User to the new area.

The folder User_Lib contains your own library files and you will probably also want to use
them for 72d Model 14.

For 12d Model 12, the default place for User_Lib is ¢:\712d\12.00\User _lib but it could also
be pointed to by the environment variable USER_LIB_4D.

If there is an existing User_Lib folder, you need to create a new User_Lib folder for
12d Model 14 and copy to it any files that you want for 12d Model 14.

The default place for the new User_Lib in 12d Model 14 is c:\12d\14.00\User_Lib but if
USER_LIB 4D in your V12 env.4d was used to point to your V12 User_Lib then you will
need to change USER_LIB_4D in your V14 env.4d to point to your V14 User_Lib folder

You may need to copy the whole of User_Lib to the new area.
Setting Up Your env.4d File for 12d Model 14
The file env.4d contains environment variables that are used to customise 712d Model.

An env.4d file is installed it the Set_Ups folder when 2d Model is installed and if a user
wants to make any modifications to any of the environment variables in env.4d, then the
modified env.4d file is placed in the User folder.

Icons Create

]
<
=
Y
B
2
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g
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So if you have an env.4d file in your User folder in 12d Model 12, you will probably also
want to use it 12d Model 14.

The default location for your modified env.4d file in 12d Model 12 is in your User folder for
12d Model 12 so for 12d Model 14, you need to copy this env.4d file to your User folder in
12d Model 14.

(d) Are you using a 12d Network Lock ?

If you are setting up 712d Model to use a 12d Network CodeMeter for the first time, please
read the section 7 What's New in 12d Model 14 on page 55.

If you are using a 12d Network Lock (CodeMeter or Wibu) for 12d Model 12, then the file
dongles.4d which is in the User folder contains the information to tell 72d Model that it has
to search for a network lock, and possibly which computer the network lock is on.

So if you are using a 12d Network Lock for 12d Model 14, you will need to copy your
12d Model 12 dongles.4d file to the 12d Model 14 User folder.

4.4 End of the Notes for Installing 12d Model 14

This ends the detailed notes for installing 72d Model 14.

If you need to set up a Network CodeMeter, go to the section 9 Network CodeMeters on
page 59.

The links for downloading documentation on 72d Model are given in 6 Documentation on
page 47.

The links for downloading information, power points and videos on what is new in 12d Model 14
are given in 7 What's New in 12d Model 14 on page 55.

The rest of the chapters in this document are
6 Documentation on page 47
7 What’s New in 12d Model 14 on page 55

8 Errors Installing and Authorising on page 56

9 Network CodeMeters on page 59
10 CodeMeter Control Center & WebAdmin on page 84
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5 Certifying CodeMeters

CodeMeters use the Certified Time capability of the CodeMeter and the CodeMeter must
communicate over the Internet with a certified Time Server every two months to check that
there is no problem with the CodeMeter, and to update the Certified time in the CodeMeter.

This process is called Certifying the CodeMeter.

Certifying a CodeMeter can be done
(a) manually from inside 12d Model itself

Already documented. See 5.1 Certifying CodeMeters from 12d Model on page 42
(b) automatically by 712d Model

Already documented. See 5.2 Automatically Certifying CodeMeters from 12d Model on
page 44

(c) outside of 72d Model when the CodeMeter is on the computer you are using outside

Using CodeMeter Control Centre - already documented in 5.3 Certifying CodeMeters
Using Control Center on page 45.

or

(d) outside 712d Model when the CodeMeter is NOT on the computer your are using

It is possible to certify CodeMeters that are on other computers but this is usually only
needed by Administrators. See 10.3.1 Certifying CodeMeters Using WebAdmin on page 94

5.1 Certifying CodeMeters from 12d Model

One month before the end of the two month period, 12d Model will bring up the Certify
CodeMeter Dongle panel which gives the number of days, minutes and seconds remaining until
Certification is required.

il Certify CodeMeter Dongle — x

Container | //testbed@fred.com/2-430111
Clocktime  |2019-09-29 05:23:04
System time |2019-09-29 05:22:58
Boxtime  |2019-09-29 05:22:08
Certify time  [2019-09-20 13:09:25

Warnings \warnings will begin in 21 days 7 hours 46 minutes 30 secends

Countdown  |needs to be certified within the next 51 days 7 hours 46 minutes 20 seconds

Cetify |  Cmdust Finish Help

The Certify CodeMeter Dongle panel can also be brought up from within 72d Model by the option

Project =>Management =>Dongles =>Certify CodeMeter
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The Certified time for that CodeMeter is updated to the current date by clicking on the Certify
button.

Important Note

There is an environment variable AUTO_CERTIFY_DONGLE_4D and if it is set on then when
the warning period is active for the CodeMeter (dongle) being used by 12d Model, 12d Model
will automatically attempt to certify the CodeMeter and if successful, no intervention by the user
is required. See 5.2 Automatically Certifying CodeMeters from 12d Model on page 44.
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5.2 Automatically Certifying CodeMeters from 12d Model

12d Model can automatically attempt to certify the CodeMeter whenever it is within the warning
period (within one month of the two months after the Certified Time).

If the environment variable AUTO_CERTIFY_DONGLE_4D to 1, whenever 12d Model is started
up, then if it is in the warning period 12d Model will automatically attempt to certify the dongle.
And if successful, no user intervention is required.

The environment variable AUTO_CERTIFY_DONGLE_4D is set by the Edit Environment
Variables panel. which is brought up by the Projects =>Management =>env.4d option.

-

i Edit Environment Variables

=-Env.dd General

- General |
[+ Files & Folders
[#- Projects |
- Dongles |
: Auto certify Codemeter

I
=000 lﬂ

i Wibu (deprecated)
[+)- Elements

- CAD

[#- Plotting

- Drainage

- MTF & Boxing

-~ Tunnel

- Views

- GUI

- Warnings and Error Reporting
- G5

- External Apps

- Wariables

p o y | Search for field | Search| |Prev.| |Mext

Finish

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Note

Any computer which has the environment variable AUTO_CERTIFY_DONGLE_4D set to 1 can
certify the Network CodeMeter that it is using to obtain a license from a 12d dongle.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.




Chapter 5 Certifying CodeMeters

5.3 Certifying CodeMete

rs Using Control Center

The Certified Time for any CodeMeter attached to your current computer can be

displayed by using the CodeMeter Control Center which is brought up by clicking a
on the CodeMeter icon that was installed on your task bar.

The CodeMeter Control Center shows any CodeMeters that are attached to the this computer.

-
@ CodeMeter Control Center

2 |

License Events Borraw

License Update

@ CmStick Name:
2-2310262

Serial:

Version:

Capadity:

Status:

2-2310262

&
CmStick 2.04
93 % free (367400 Bytes)

@ @ Disabled
5] (& Enabled until unplugged

@ Enabled
Eject Change Password

CodeMeter is started.

The Certified Time in a CodeMeter that is on this computer can be displayed and updated by
clicking on Process >Update Time Certificates

& CodeMeter Control Cente

‘_ Update Time Certificates
(= (&) Repair Hardware Configuration Name:

(¥) Start CodeMeter Service
@ Stop CodeMeter Service

Serial:

Version:

Capacity:

Status:

License Update

CmsStick 2.04

2-2310278
93 % free (367432 Bytes)

@ Disabled
] (2 Enabled until unplugged

@ @ Enabled |
Eject Change Password

CodeMeter is started.

[ =

s

Certifying CodeMeters Using Control Center Page 45

= = = e o= e 7 X
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Note

If the CodeMeter is not on the computer you are using the then certifying the codemeter
must be done using CodeMeter WebAdmin (see 10.3.1 Certifying CodeMeters Using

WebAdmin on page 94).
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6 Documentation

See

6.1 12d Model Reference Manual on page 47

6.2 Getting Started for Design Manual on page 49

6.3 Getting Started for Surveying Manual on page 51

6.4 12d Model Programming Language Manual on page 53

6.5 12dxml File Format on page 54
6.6 12da File Format on page 54
7 What's New in 12d Model 14 on page 55

6.1 12d Model Reference Manual

The 12d Model Reference manual contains the technical information required for using
12d Model includes information such as:

(a) the tools and concept used in 72d Model

b) descriptions of the 12d Model screen layout, views and toolbars
c) information on each 72d Model menu
d

~

technical information on the fields in each 72d Model panel
e) information on all the set up files for 12d Model. E.g. for colours and linestyles

(
(
(
(
(f) information on the 12d XML and 12da formats

Although the 712d Model Reference manual contains some information on each of the field in
panels, it is the technical information about what is valid values etc and is not intended to be a full
description on how all the options work together. That is, it is NOT a training manual.

The 12d Model Reference manual also acts as a context sensitive Help system when
12d Model is running.

That is, when 72d Model is running:

(a) for most menus in 712d Model, when the menu is on the screen and has the Windows focus,
pressing F1 will open the 712d Model Reference manual at that menu

(b) for most panels in 72d Model, when the panel is on the screen and has the Windows focus,
pressing F1 will open the 72d Model Reference manual at that panel. Or if the panel has a
Help button, clicking on the Help button opens the 712d Model Reference manual at that
panel.

The full 12d Model Reference manual is can be accessed from within 72d Model by clicking on
the option Help =>12d Model.
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Help E

12d Macro Manual

What's Mew

What's Mew Summary
Getting Started for Design
Getting Started for Surveying

12d on the Web 3
About 12d Model

Ernail info to 12d

Dongles

Check for updates

Systern Information

User r

The 12d Model Reference is a pdf file and when 12d Model is installed, it is copied into the
Help folder.

Local Disk (C:) » Program Files » 12d » 12dmodel » 1400 3 help

s

Mame

12d.pdf
12D_PROG‘M
& 12D _Track.chm

12d_View.pdf
12dm_getting_started_for_design.pdf
12dm_getting_started_for_surveying. pdf

Whats_Mew_in_12d_Model_14.pdf
n Whats_MNew_Summary_in_12d_Maodel_14.htm

<1 2d Model Reference manuaD

To download a zipped copy of the12d Model Reference manual,12d.pdf, click on the following
link and then unzip the downloaded file

https://downloads.12dmodel.com/v14/12d_Model 14 C2m/12d.zip

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

Continue to 6.2 Getting Started for Design Manual or return to 6 Documentation.
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6.2 Getting Started for Design Manual

WARNING
At the moment this is only the Getting Started for Design manual for 712d Model 12

12d Model is supplied with a comprehensive on-line 12d Model Reference manual which
describes the function of each menu option in detail. However, it is a Reference manual and
makes no attempt to describe how to use 72d Model for production surveying and civil
engineering work.

The 12d Model Getting Started for Design manual is designed to show you how to work with
the context sensitive help system, and then as the first section of Training, help you start to learn
how to use 712d Model to achieve typical civil engineering tasks.

Wherever possible, The 12d Model Getting Started for Design manual uses examples to
clarify usage. It compliments rather than replaces the 712d Model Reference manual. In general,
information in the 72d Model Reference manual will not be duplicated in the 12d Model Getting
Started for Design manual.

The 12d Model Getting Started for Design manual can be accessed from within 12d Model by
clicking on the option Help =>Getting Started for Design

Help n

12d Meodel Reference manual
12d Macro Manual
What's New

(Getting Started for Design )

Getting Started for Surveying

12d on the Web 3
About 12d Model

Email info to 12d

Dongles

Check for updates

Systermn Information

User r

The 12d Model Getting Started for Design manual is a pdf file and when 72d Model is
installed, it is copied into the Help folder.

Local Disk (C:) » Program Files » 12d » 1l2dmodel » 14.00 » help

Py

Mame

12d.pdf
12D_PROGM.pdf
2 12D_Track.chm (1 2d Model Getting Started for DesigrD
12d_View.pdf
12dm_getting_started_for_design.pdf
12dm_getting_started_for_surveying.pdf
Whats_Mew_in_12d_Model_14.pdf

n Whats_Mew_Surmmary_in_12d_Model_14.htm

To download a pdf copy of the 712d Model Getting Started for Design manual, click on the
following link
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https://downloads.12dmodel.com/v14/12d _Model 14 C2m/12dm_getting_started for design.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

Continue to 6.3 Getting Started for Surveying Manual or return to 6 Documentation.
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6.3 Getting Started for Surveying Manual

WARNING
At the moment this is only the Getting Started for Surveying manual for 12d Model 12

12d Model is supplied with a comprehensive on-line 12d Model Reference manual which
describes the function of each menu option in detail. However, it is a Reference manual and
makes no attempt to describe how to use 72d Model for production surveying and civil
engineering work.

The 12d Model Getting Started for Surveying manual is designed to show you how to work
with the context sensitive help system, and then as the first section of Training, help you start to
learn how to use 12d Model to achieve typical surveying tasks.

Wherever possible, The 12d Model Getting Started for Surveying manual uses examples to
clarify usage. It compliments rather than replaces the 712d Model Reference manual. In general,
information in the 72d Model Reference manual will not be duplicated in the 12d Model Getting
Started for Surveying manual.

The 12d Model Getting Started for Surveying manual can be accessed from within 72d Model
by clicking on the option Help =>Getting Started for Surveying

Help n

12d Meodel Reference manual
12d Macro Manual

What's New

What's New Summary
Getting Started for Desion
@etting Started for SuweyingD

12d on the Web »
About 12d Model

Email info to 12d

Dongles

Check for updates

System Information

User »

The 12d Model Getting Started for Surveying manual is a pdf file and when 712d Model is
installed, it is copied into the Help folder.

Local Disk (C:) » Program Files » 12d » 1l2dmodel » 1400 > help

Mame

12d.pdf
12D_PROGM.pdf
@ 120 _Track.chm (1 2d Model Getting Started for SurveyingD
12d_View.pdf
12dm_getting_started_for_design.pdf /
12drn_getting_started_for_surveying.pdf
Whats_Mew_in_12d_Model 14.pdf

n Whats_Mew_Surmmary_in_12d_Maodel_14.htm

To download a pdf copy of the 712d Model Getting Started for Surveying manual, click on the
following link
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https://downloads.12dmodel.com/v14/12d _Model 14 C2m/12dm_qetting started for surveying.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

Continue to 6.4 12d Model Programming Language Manual or return to 6 Documentation.

Page 52 Getting Started for Surveying Manual

E— = = = ——— ————= = = = 72
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6.4 12d Model Programming Language Manual

The 12d Model Programming Language (12dPL), is a powerful programming language
designed to run from within 12d Model. It is also known as 4DML from when the product was
called 4d Model.

Its main purpose is to allow users to enhance the existing 12d Model package by writing their
own programs. These programs are often called macros.

The 12d Model Programming Language manual is a reference manual and does not try to
teach programming techniques. Instead this manual sets out the syntax, restrictions and
supplied functions available in 12dPL.

The 12d Model Programming Language manual can be accessed from within 12d Model by
clicking on the option Help =>12d Macro Manual

Help n

nual
12d Macro Manual

What's New

What's New Summary
Getting Started for Design
Getting Started for Surveying

12d on the Web »
About 12d Model

Email info to 12d

Dongles

Check for updates

System Information

User »

The 12d Model Programming Language manual is a pdf file and when 712d Model is installed,
it is copied into the Help folder.

Local Disk (C:) » Program Files » 12d » 1l2dmodel » 14.00 » help

Py

Mame

12d.pdf
12D_PROGM.pdf
@ 120 _Track.chm (1 2d Model Programming Language manuaD
12d_View.pdf
12dm_getting_started_for_design.pdf
12dm_getting_started_for_surveying.pdf
Whats_Mew_in_12d_Model_14.pdf

n Whats_Mew_Surmmary_in_12d_Model_14.htm

To download a pdf copy of the 12d Model Programming Language manual,12d_prog.pdf, click
on the following link

https://downloads.12dmodel.com/v14/12d_Model 14 C2m/12d progm.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Continue to 6.5 12dxml File Format or return to 6 Documentation.

E— = = = = = = 2 2 72
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6.5 12dxml File Format

The 12dxml file format is a text file definition from 12d Solutions which is used for reading and
writing out string data from 72d Model. 12dxml files normally end in .12dxml.

The 12dxml file is a Unicode file.

The documentation for 12dxml is part of the 12d Model Reference manual (see 6.1 12d Model
Reference Manual) but the chapter as also been separated out so the entire 12d Model
Reference manual is not needed.

To download a pdf copy of the 72d Model 12dxml manual, click on the following link
https://downloads.12dmodel.com/v14/12d_Model_14_C2m/12d_12dxml_File_Format Nov_19.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Continue to 6.6 12da File Format or return to 6 Documentation.

6.6 12da File Format

The 12da (12d Archive) file format is a text file definition from 12d Solutions which is used for
reading and writing out string data from 712d Model. 12da files normally end in .12da.

The 12da file is a Unicode file.

The documentation for 12da is part of the 72d Model Reference manual (see 6.1 12d Model
Reference Manual) but the chapter as also been separated out so the entire 72d Model
Reference manual is not needed.

To download a pdf copy of the 12da File Format manual, click on the following link
https://downloads.12dmodel.com/v14/12d_Model 14 C2m/12d_12da_File_Format Nov_19.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Further Notes:

1. 12da was originally an Ascii file and stood for 12d Ascii but now that the 12da file is a
Unicode file, 12da stands for 12d Archive.

2. 12da has now been superseded by 12d xml (see 6.5 12dxml File Format)

Continue to 7 What's New in 12d Model 14 or return to 6 Documentation.
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7 What’s New 1n 12d Model 14

This chapter contains links to information on many of the new things in 12d Model 14.

See
7.1 What's New Summary for 12d Model 14 on page 55
7.2 What's New Summary for 12d Model 14 by Sub-Version on page 55
7.3 What's New in 12d Model 14 pdf on page 55

7.1 What's New Summary for 12d Model 14

A one line summary of all the additions in 72d Model 14 sorted by Component:

https://downloads.12dmodel.com/V14/12d_Model_14 C2m/WNS _12d_Model 14 _C2m_all.htm

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

7.2 What's New Summary for 12d Model 14 by Sub-Version

A one line summary of all the Additions in 72d Model 14 broken into sub-versions (i.e. C1a, C2b,
C2c etc) and subsorted by components:

https://downloads.12dmodel.com/V14/12d_Model 14 C2m/WNS 12d Model 14 C2m_all_split.htm

Note: If clicking on the link does not start up your Browser then copy the text of the link into your
Browser.

7.3 What's New in 12d Model 14 pdf

The What’s New in 12d Model 14 pdf gives detailed information on many of the new options
and features in 72d Model 14.

https://downloads.12dmodel.com/V14/12d Model 14 C2m/Whats New in_12d Model 14.pdf

Note: If clicking on the link does not start up your Browser then copy the text of the link into
your Browser.

Return to 7 What's New in 12d Model 14.
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8 Errors Installing and Authorising

See
8.1 12d Model XX Not Authorising on page 56
8.2 Licence Expiry Warning on page 57

8.3 Dongle Missing on page 58

8.1 12d Model XX Not Authorising

If there is an error with the installation, then the Error Authorizing Release Version panel appears
with the error messages in the panel message area.

For example, for 12d Model 11

:ﬁ Autheorization Error

12d Model

Summary |Authorizati0n details | Dongle administration |

An error occurred while authorizing this copy of 12d Model!

Date  21-10-14 17:23:42 A valid Company means that a nodes.4d file has
o : g - - ..

Company 12D Solutions - Lee been read and there is a V11 entry in it

User lig

n .4d file found an in
Nodes.4d file found c:\12d\11.00\nodes.4d <& odes.4d file found and being used

12d Model tried to login to the following dongles no 12d dongle detected

Dongle Type f;:ﬁl ‘:/ Search location Status
New dongle codemeter_auto_local dongle| UNKINOWN |Local Computer ¢ Soloealiconices bowd

[What to try next?

Check the "Authorization details" tab for errors

Malce sure any local dongles are plugged in.

Make sure the computer can see all local dongles. (Did you plug the dongle into a different USB port?)
Malke sure the local service is running.

Only vour local computer was searched. Do you have a network dongle that needs to be configured?

SR SR

Installation messages
and error messages area

[Running msinfo32.exe in the background, so no need te wait until it finishes! |

Email support | Help |

Projects Dongles Env.dd | | Quit

In the above panel, the UNKNOWN in the Dongle number column shows that no 72d dongle
has been detected.
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If there is no error message on the panel or it is still not obvious what the problem is, please
contact your 12d Model Reseller.

8.2 Licence Expiry Warning

The nodes.4d file that controls 72d Model, only validates 72d Model to run for a certain period
of time.

If when running 72d Model, the Licence Expiry Warning panel appears:

ifl Licence Expiry Waming ‘ @

The current licence finishes in 14 days (Thursday, June 18, 2015) at 23:59

If you have entered a new code further down in the file,

it will be used when this one expires

You may wish to make the new one current now to test it

(oK)

——— —

it simply means that the nodes.4d file needs to be updated.

Please contact your 12d Model Reseller to obtain a new nodes file before the given date. If this
is not done then 72d Model will no longer run until you do obtain and install a new nodes file.
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8.3 Dongle Missing

If when running 72d Model, the Dongle Missing panel appears:

Dongle Missing

Dengle administration

4 &ll Dongles I

[ Looking for dengle /

|  Rety || Dongleretry |[Saveand exiti2d|| Exitl2d |

it simply means that the 72d dongle can no longer be seen by 712d Model.

Please check that your 12d dongle is still attached to your computer, or if you are using a
network dongle, that your network is still active.

Then click on Retry, and if that doesn’t work, click on Dongle retry.

Even if you still can not see the dongle, 12d Model will allow you to save your current work so
that nothing is lost by clicking on the Save and exit 12d button.
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A 12d Local CodeMeter (also known as a Standalone or single-user CodeMeter) is a
CodeMeter that is attached to a computer and only allows 72d Model to be run on that
computer only.

If the 712d Local CodeMeter is to be used on another computer then the 12d Local CodeMeter
must be moved to the other computer. This means that 12d Model will no longer run on the
computer that no longer had the 12d Local CodeMeter.

This is the default installation for 712d Model.

A 12d Network CodeMeter is a CodeMeter that controls a number of 712d Model licenses and
the 12d Network CodeMeter can potentially be accessed by any other computer on the
network and allows copies of 12d Model to be run on those computers without needed a 12d
Local CodeMeter.

The 12d Model licenses controlled by the 712d Network CodeMeter can be accessed and used
in any country and any time zone, subject to any Australian and local Laws that may prevent it.
The only restriction is that each instance of 72d Model on a computer requires its own

12d Model license from the 12d Network CodelMeter.

12d Network CodeMeters are metallic and a silver colour, and are labelled with a number
starting with ec.

// 12d Local CodeMeter also referred to as a \ KZd Network CodeMeteN

Single User or Standalone CodeMeter

Silver USB
Stubby USB Long USB
with end cap without end »
Micro SD and ring cap and ring o y-

/\ oy i :;
| gﬂ \\’[.i" ' o/
K\ Note: the end cap and ring are cosmetic only j K J/

Note: When using a 12d Network CodeMeter, each running copy of 712d Model using a 12d
Network CodeMeter on a computer requires a license from the 12d Network CodeMeter.

If your computer is not using a 12d Local CodeMeter and is only using a 12d Network
CodeMeter to obtain 712d Model licenses then 712d Model and the CodeMeter Drivers still need
to be installed on the computer that is wanting to run 72d Model.

BUT when 72d Model is installed it is set up for users with a Local (single user or stand alone)
CodeMeter and installs a dongles.4d file that assumes that 12d Model is only using a 12d
Local CodeMeter and has no access to a 12d Network CodeMeter.

So to access a 12d Network CodeMeter, the dongles.4d file needs to be modified and the
nodes.4d file you use will need to contain an authorization for the 12d Local CodeMeter.

Note: a computer can be set up to look for both a 72d Local CodeMeter and a 12d Network
CodeMeter.

To install the Network CodeMeter and configure computers to use the Network CodeMeter, you
will need
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1. First Install the CodeMeter drivers
IMPORTANT WARNING

Do not attach any CodeMeters, Network or Standalone, to your computer until after you have
installed the CodeMeter Drivers.

The latest CodeMeter Drivers installation program 12d_dongles_installation_date.exe is
downloaded from:

https://downloads.12dmodel.com/v14/12d_Model 14 C2m/12d lock drivers Install 16 _Aug_19.exe

2. anodes.4d file to authorize the 12d Model xx licenses controlled by the 12d Network
CodeMeter where xx is the 12d Model versions required.

This is usually supplied in an email a the attached file nodes.12dxxn (for example, for
12d Model 14, it will be nodes.12d14n)

Or you may already have it in a folder with the 12d Model authorization file nodes.12dxxn or
nodes.4d in it.

Full instructions setting up Network CodeMeters, and making the required modifications to the
dongles.4d file and the nodes.4d file, are given in the rest of this chapter.

Continue to 9.1 Definitions and Guide to the Network Notes on page 61.
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9.1 Definitions and Guide to the Network Notes

A 12d CodeMeter Server is a computer with a 12d Network CodeMeter attached to it. Note that
this can be any computer, it does not have to be a Server Computer.

A 12d CodeMeter Client is a computer that gets its 712d Model licenses from a 12d CodeMeter
Server. The CodeMeter Client computer does not have a 12d Network CodeMeter attached to it.

~

(CodeMeter Client>

(CodeMeter Client)

<CodeMeter Client>
CodeMeter Server <CodeMeter Client>
computer with a
Network CodeMeter| :
(CodeMeter Client\ CCodeMeter Clzent>
% CodeMeter Server
computer with a
Network CodeMeter| <C0deMeter Client>
<CodeMeter Client> <CodeM eter Cliem)

(C odeMeter Client)

K CodeMeter Client Computers Networked to One or More CodeMeter Server Computey

Both CodeMeter Servers and CodeMeter Clients must have the CodeMeter Drivers and
CodeMeter Runtime Server service installed and running and this is described in 9.2 Installing
CodeMeter Drivers on page 63.

CodeMeter Servers must also have the CodeMeter Network Server running and this is
described in Step 6. Starting the 12d Network Server on page 71.

To run 12d Model on a CodeMeter Client, an appropriate dongles.4d and valid nodes.4d file
must be obtained and set up. This is describing in 9.4 dongles.4d and nodes.4d on page 73.

These notes are for
(a) Installing and setting up a new 12d Network CodeMeter to act as a 12d License server

(b) Setting up other computers (Clients) so they can access the Network CodeMeter and
12d Model licenses in the 12d Network CodeMeter.

(c) Setting up/Updating dongles.4d to instruct the other computers (Clients) which Network
CodeMeters to use. This can be down to the level of using a particular virtual 12d dongle
inside a particular 12d Network CodeMeter.

(d) Setting up/Updating the nodes.4d file with the authorization to match the 12d dongle being
accessed inside a 12d Network CodeMeter.

(e) Updating the 12d Model licenses in a 12d Network CodeMeter
and
(f) Monitoring 12d Network CodeMeters.

WARNING
If the computers accessing a 12d Network CodeMeter are in a different subnet (behind a
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router) to the 12d Network CodeMeter then 12d Model needs to be given the IP address or the
computer names of the servers with the 72d Network CodeMeter. This will be explained later in
the notes. This will also apply to computers connected by Wireless or DHCP.

If you already have a 12d Network CodeMeter and are simply updating a 72d dongle inside the
Network CodeMeter, go to the section 10.5 Updating Licenses in Network CodeMeters on

page 116.

if your are installing a 12d Network CodeMeter on the computer for the first time, please
continue to the next section 9.1 Definitions and Guide to the Network Notes on page 61.

Important Note for Going From 12d Local CodeMeters to 12d CodeMeter Servers

The CodeMeter drivers are exactly the same ones that are used for a 12d Local (standalone or
single-user) CodeMeter. So if a computer is already been used for a 12d Local CodeMeter with
12d Model, then the CodeMeter drivers have already been installed and will not need to be
installed again.

This means that if a 12d Network CodeMeter is introduced, all the computers that are currently
running 72d Model with a Local CodeMeter will not need the CodeMeter drivers installed.

However, such CodeMeter Client computers will need a modification to their dongles.4d file to
tell the computer that 72d Model licenses can be obtained from a 12d Network CodeMeter
rather than just a 12d Local CodeMeter (see 9.4 dongles.4d and nodes.4d on page 73).

Also a valid nodes.4d file for the 12d dongle inside the 12d Network CodeMeter is needed
(see 10.5 Updating Licenses in Network CodeMeters on page 116).
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9.2 Installing CodeMeter Drivers

IMPORTANT WARNING - Do not attach a 12d CodeMeter to your computer until after you have
installed the CodeMeter drivers.

This section is installing the CodeMeter drivers.

This must be done on the computer that will have the 12d Network CodeMeter attached to it (the
CodeMeter Server) and also for all the computers that are 12d CodeMeter Clients using the
CodeMeter Server.

If the computer has no CodeMeter Drivers, or old CodeMeter Drivers, installed on it, go to Step
1. Install the CodeMeter or Older Wibu Drivers on page 15.

If a computer is to become a CodeMeter Sever but already has the CodeMeter Drivers installed
on it, then go straight to 9.3 Setting up a 12d Network CodeMeter on page 66.

If the computer is already set up as a CodeMeter Server and you are adding a new 12d dongle
to the 12d Network CodeMeter, or upgrading the number of 12d licenses on a 12d dongle in the
12d Network CodeMeter, go to 10.5.1.1 Updating Using the .WibuCmRaU File on page 120.

If you are replacing the existing 12d Network CodeMeter by a new 12d Network CodeMeter, go
to 10.6 Replacing an Existing Network CodeMeter on page 124.

Installing CodeMeter Drivers Page 63
e = = = > <= 7 —Z
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What is Done to the Computer By Step 1

1. CodeMeter Drivers

The CodeMeter drivers that allows software to access CodeMeters anywhere on the network is
installed.

2. CodeMeter Runtime Server

The service CodeMeter Runtime Server service is also installed and started on the computer
and if you look in the Services tab of the Windows Task Manager, the CodeMeter Runtime
Server will be shown as Running.

18 Windows Task Manager

File

Options  View Help

| Applications | Processes | Services | performance | Metworking | Users |

=
Name PID Description Status Group
dr_optimization_v4.0.30319_64 Microsoft .MET Framework NGEM v... Stopped M
CodeMeter.exe 12464 CodeMeter Runtime Server Running M

S TOTTSTERND LW & Sy = ) (e Y] Y] ng ]2 IR

If for some reason the CodeMeter Runtime Server is shown as Stopped, to restart it again go
to Step 6. Starting the 12d Network Server on page 71.

3. CodeMeter Icon

As well as installing the CodeMeter drivers., a CodeMeter icon is installed on
your task bar

Clicking on the CodeMeter icon brings up the CodeMeter Control Center which shows any
CodeMeters that are attached to the this computer. The CodeMeter Control Center also has
options to stop and start the CodeMeter Runtime Server and bring up the WebAdmin panel to
examine the content of CodeMeters anywhere on the network.
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’ ~
@ CodeMeter Control Center Y
License Events Borrow
@ CmStick Mame:

2-2310262

Serial: 2-2310262

€ ©

Veersion: CmStick 2,04

Capacity: 93 % free (367400 Bytes)

Status: @) @Disabled

(2 (g Enabled until unplugged

@ Enabled
License Update Eject Change Password
CodeMeter is started. WebAdmin
\ .

If the computer is to be a CodeMeter Server, then the next step is to check the Network
CodeMeter. If this is the case then go to 9.3 Setting up a 12d Network CodeMeter on page 66.

If the computer is a CodeMeter Client, then the next steps are to

(a) set up the dongles.4d file to see the 12d Network CodeMeter (and if required a particular
12d dongle inside the 12d Network CodeMeter)

and
(b) set up the nodes.4d with the authorization for the required 12d dongle number.

For setting up dongles.4d and nodes.4d, see 9.4 dongles.4d and nodes.4d on page 73.
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9.3 Setting up a 12d Network CodeMeter

The CodeMeter drivers are now installed and the CodeMeter Runtime Server is running.

The next steps are to actually attach the 12d Network CodeMeter, examine its contents to make
sure everything that are correct, and then start up the 12d Network Server so that other
computers in the network will be able to see and use the 12d Network CodeMeter.

These steps will complete the setting up of the 12d Network CodeMeter as a 12d CodeMeter
Server.

Step 2.Attaching the Network CodeMeter

The physical CodeMeter number can be found on the part of the 12d Network CodeMeter that
is pushed into the USB port (the CodeMeter shaft). The number starts with 2-.

This number needs to be recorded but you need to have very good eyes to be able to read it or
have a magnifying glass.

If the CodeMeter number can’t be read, it is also possible to obtain the number after the 12d
Network CodeMeter is plugged into the USB port of the computer (see Step 3. Checking that the

12d Network CodeMeter is Visible on page 67.)

a 12d Network CodeMeter - Silver USB I

CodeMeter number ~ —_ o -..

/ EL”‘:*D .

&
\ ey _.-l".;'II /

Now that the CodeMeter drivers are installed on the computer, the 12d Network CodeMeter can
now be attached to the USB port on the computer.

Page 66 Setting up a 12d Network CodeMeter
= = = L 7 X
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Step 3.Checking that the 12d Network CodeMeter is Visible

Click on the CodeMeter icon that was installed on your task bar —— g
to bring up the CodeMeter Control Center which shows what
CodeMeters are on this computer.

@ CodeMeter Control Center S

License Events Borrow

@ CmStick

Mame:
2-2310262

Serial: 2-2310262

@ B [~

Version: CmStick 2.04

CodeMeter number
Capacity: 93 % free (367400 Bytes)

Status: @ @Disabled

() \&y Enabled until unplugged

@ Enabled
License Update Eject Change Password
CodeMeter is started. WebAdmin

e

A

The CodeMeter number, that is written on the shaft of the CodeMeter, should be displayed in the
CodeMeter Control Center.

Step 4.What to Do If You Can’t See the CodeMeter

If you were unable to see the CodeMeter number in the CodeMeter Control Center then first
check that the service CodeMeter Runtime Server service is installed and running on the
computer by looking in the Windows Task Manager and checking that CodeMeter Runtime
Server is shown as Running.

18 Windows Task Manager

File Options View Help

| Applications | Processes | SEMVices | Performance | Metworking | |Jsers |

=
MName PID Description Status Group
dr_optimization_v4.0.30319_64 Microsoft \MET Framework NGEM v... Stopped M/
CodeMeter.exe 12464 CodeMeter Runtime Server Running MA
TS YEERE T Sy e ter Appea tan e ]a [T} TR

If for some reason the CodeMeter Runtime Server is there but shown as Stopped, to restart it
again see Step 6. Starting the 12d Network Server on page 71.

If you are still having problems then contact your 72d Model Reseller.
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Step 5.Checking the Virtual 12d Virtual Dongles Inside the Network CodeMeter
The 12d Network CodeMeter alone is not enough to provide a license to run 72d Model.
There must also be a 12d virtual dongle inside the Network CodeMeter.

Itis the 12d virtual dongle that controls how many network licenses of 12d Model are.available.

Aside:

The 12d virtual dongle issues the 712d Model licenses but the actual 12d Model modules
that go with a license from a 12d virtual dongle is controlled by a matching entry in the
nodes.4d file. This means that what 712d Model modules you have can be updated by just
adding a new entry for the nodes.4d file. The word virtual is used because the 12d virtual
dongle is NOT a physical lock. The 12d virtual dongle is often abbreviated to 12d dongle.

Clicking on the WebAdmin button on the CodeMeter Control Center brings up the CodeMeter
WebAdmin panel which is used to display information about any of the CodeMeters that it can
see. Note - you may have one of two versions of WebAdmin - see 10.8 Which Version of
WebAdmin? on page 125.

For WebAdmin 6:

Clicking on the tab Content >Licenses of the CodeMeter WebAdmin panel displays the
12d virtual dongle information stored in the selected CodeMeter.

<« ¢ o @ build-server.12d.com:22350/container/emcontainer_details.html?BoxSerial= see [# mn o =

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container v License Monitoring v  Diagnosis ¥  Configuration v  Info

E All Container <no name> (2-2310233) (2] B English (US) ~
P <no name> 2-2310233 CmStick 2.04 @
7
X% A Licenses CmContainer Info Backup & Restore

A 100003 Bundling Articles

Product Code Name Unit Counter Valid Until License Quantity Feature Map
1 SecurikKey Lite nfa nfa 1 0x1

A 101956 12d.com

Product Code Name Unit Counter Valid Until License Quantity Feature Map
1 12d Model - Stock - 12d Solutions - ec51470113 nfa nfa 5 nfa
1 12d Model ec51470114 nfa nfa 25 nfa

Current Server: BUILD-SERVER (192.168.68.252) % i WebAdmin Version: 6.4/)

12d Product name 12d virtual dongle number Total number of licenses on
12d Customer hame the 12d virtual dongle

For instructions on how to select and see CodeMeters on a particular 12d Network Server,
see 10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 103

For WebAdmin 5:

Clicking on the tab Content >Licenses of the CodeMeter WebAdmin panel displays the
12d virtual dongle information stored in the selected CodeMeter.
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CodeMeter WebAdmin C‘v]
LT content arver  Configuration Diagnosis Info Help

CmContainer Licenses User Data Backup/Restore

CmContainer: [2-2310262 [v]

100003 | Bundling Articles

Product A Unit Expiration Activation License
Code Counter Time Time Quantity
1 Securikey Lite nfa n/a n/a 1

101956 | 12d.com

Product Name Unit Expiration Activation License
Code Counter Time Time Quantity
B 12d Model
= /1 ecs1470022 % /a e L 2
/ | ’
12d Product name 12d Customer name Total number of licenses on
the 12d dongle

12d virtual dongle number

For instructions on how to select and see CodeMeters on a particular Network Server, see
10.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 110

If there are no 12d dongle numbers displayed inside the 12d Network CodeMeter, or no 12d
dongle number starting with ec, contact your 72d Model Reseller.

You need to make a note of the 12d dongle number because there must be a valid entry with
the matching 12d dongle number in the nodes.4d file.

Note: The WebAdmin button is only selectable if the CodeMeter Runtime Server is running. If
it is Stopped, to restart it again see Step 6. Starting the 12d Network Server on page 71.

Important Note:

There may be more than one 12d dongle number inside the one physical CodeMeter
Container. That is why they are also referred to as virtual 12d dongles. For example,
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E All Container

<Nno name>
C\
% A Licenses

- @ WebAdmin | Container x
e

+

c ‘Q‘ @ build-server.12d.com:22350/container/ecmcontainer_details.html?BoxSerial= v @ ﬁ

SYSTEMS

Dashboard Container ~

CodeMeter WebAdmin

License Monitoring ~ Diagnosis ~ Configuration v Info

<no name> (2-2310233) @ =

2-2310233 CmStick 2.04

English (US)

CmContainer Info Backup & Restore

( two 12d dongle numbers in the CodeMeter }

each 12d dongle

nit Counter Valid

~

Current Server: BUILD-SERVER (192.168.68.252) %

= ==

Product Code Name

1 SecurKgWNlte

101956

1 12d Model - St

1 12d Model - Stock - 12d Solutions - ec51470114

- 12d Solutions - ec51470113

Number of licenses on

nfa n/a 1

Unit Counter WValid Until

WebAdmin Version: 6.40

Ox1

License Quantity Feature Map

nfa n/a 5
nfa n/a 25

v

Within 72d Model, it is possible to address specific 12d Network CodeMeters, and specific 12d
dongles within a 12d Network CodeMeter. This is done via the dongles.4d file and how it is set
up is described in 9.4.1 Updating dongles.4d on page 73.

Setting up a 12d Network CodeMeter
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Step 6.Starting the 12d Network Server
For a 12d Network CodeMeter to be seen and used by other computers in the network, the 12d
Network Server needs to be running on the computer with the 12d Network CodeMeter on it.
The CodeMeter WebAdmin panel is used to start the 12d Network Server.

Note: The 12d Network Server is controlled by the CodeMeter Runtime Server service so it is
critical that the CodeMeter Runtime Server service is running.

To bring up the CodeMeter WebAdmin panel, click on the WebAdmin button on the CodeMeter
Control Center.

For WebAdmin 6:
In the CodeMeter WebAdmin panel, click on the Configuration >Server >Server access

menu.
- & WebAdmin | Server Access b + - O
&« ( ‘@‘ ® localhost:22350/configuration/server_access.html e 1:? N @
CodeMeter WebAdmin C
SYSTEMS

Dashboard Container ~  License Monitoring v  Diagnosis v~
E Server Configuration Server Access Basic 5 (2] B English (US)
Server Access License Access Permissions (Server >| Server Access )
—Network Server Advanced License Access Permiss
O Disable
MNetwork Port *: 22350

—CmWAN Server
O Disable

® Enable
CmMWAN Port *: 22351 |

Apply Restore Defaults

(*) Changes only take effect after restarting CodeMeter

Click on Enable and then Apply.
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For WebAdmin 5:

In the CodeMeter WebAdmin panel, click on the Configuration >Server tab and then tick on

Run Network Server.

CodeMeter WebAdmin C\/J

| Home Content Server [LUMHLLIL" Diagnosis Info Help

Network Server Proxy Access Control Certified Time WebAdmin Backup Borrowing

Server
Bind Address: All (Default)
Run Network Server: [
Network Port =: |2235E}I
Run CmWAN Server: [
CMWAN Port =: [22351 |
Apply || Default

(*) Changes only take effect after restarting CodeMeter

Click on Apply and a message Operation completed successfully - please wait will
appear and when it disappears, the above panel is displayed again.

The 12d Network Server should now be running.

Note that unlike the CodeMeter Runtime Server service, the 12d Network Server is not a
service and so will not appear in the Windows Task Manager.

The computer with the 12d Network CodeMeter is now ready to use as a 12d CodeMeter
Server.
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9.4 dongles.4d and nodes.4d

9.4.

For 12d Model to be able to create and/or open existing projects, it requires

(a) alicense from a 12d dongle inside a 12d Network CodeMeter

and

(b) a valid entry with the matching 12d dongle number in the nodes.4d file

Once dongles.4d and nodes.4d have been updated, they must be the nodes.4d and

dongles.4d files that are used for any computer wanting to use a 72d Model license from the
12d Network CodeMeter.

For the updating of dongles.4d, see 9.4.1 Updating dongles.4d on page 73.

For the updating of nodes.4d, see 9.4.2 Updating nodes.4d on page 81.

1 Updating dongles.4d

The dongles.4d file lists the computers to search for 12d Network CodeMeters, 12d Local
CodeMeters and Wibu dongles to find 12d dongle numbers.

It also defines the order to search for CodeMeters and Wibus.

When 12d Model is installed on a computer, it installs a dongles.4d file that is configured to only
look for Local (standalone) CodeMeters and Local Wibus.

For each computer that needs to access to a 12d Network CodeMeter, a modification has to be
made to the dongles.4d file used by that computer to tell 72d Model to search for a 12d
Network CodeMeter and not just use a 72d Local CodeMeter.

The updated dongles.4d is then placed in the standard search path for a set up file for that
computer and the particular version of 72d Model. For example, for 12d Model 14, the
dongles.4d could be in c:\12d\14.00\User. Or it uses a file pointed to by the environment
variable DONGLES_4D in env.4d. This means that the dongles.4d file could be on the one
central computer and accessed by all the other computers.

Important Note

In the initial 72d Model installation, the dongles.4d file is a set up file and is installed in the
Set_ups folder under the 72d Model version number.

For example, for 12d Model 14
Program files\12d\12dmodel\14.00\Set_ups

All the files in Set_ups are supplied by 12d Solutions and must not be modified. Hence in
updating the default dongles.4d file, the procedures outlined will modify a copy of the
dongles.4d file.

The editing of dongles.4d does not have to be on the computer that the 12d Network
CodeMeter is on. It can be done from any computer.

To edit the donges.4d file you need to start up 12d Model BUT you don’t have to open a
12d Model project. The current dongles.4d file can be edited by simply starting up 72d Model
and clicking on the dongles.4d button on the front panel.



12d Model

E]
I
Dongles.4d Quit

Or if the 12d Model you are running is already authorized and you are in an open project, by

picking the option

Projects =>Management =>Dongles =>Dongles.4d editor

Both of these bring up the Dongles.4d Editor panel.

If the dongles.4d is the one installed with 12d Model then it will only be looking for Local
(standalone) CodeMeters and Local (standalone) Wibus:

/

o

Add a new entry

i@ Dongles.dd Editor

M Add | Delete R4
Codemeter Local

Wibu Local

List of CodeMeter
and Wibu dongles to
search for.

They are searched
for in the order in this
list.

Type

Mame

Active

Filter

# retries

Wait time (seconds)

Codemeter - Auto L.,

Codemeter Local

true

0.01

~

Pt

-
kg

| is valid

Write

Finish

Help |

=~

What it needs in the list is an entry to tell 72d Model to look for your 72d Network CodeMeter.

To Add a new entry to dongles.4d, click on the Add button which then bring up the

Add a New Dongle panel.
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-

if Add a new dongle = 2
Type |Codemeter - auto network e |
| Select Choice @
— Wibu - local and auto local
[Add ] [F'”'S‘h] [HEIP‘] Wibu - network
L Wibu - auto netwaork

Codemeter - local
Codemeter - auto local
Codemeter - network
Codemeter - auto network
Pause

To add an entry to search for all Network CodeMeter on the network, see 9.4.1.1 Search for any
12d Network CodeMeter on page 75.

To add an entry to use a particular 12d dongle number in a particular 12d Network CodeMeter,
see 9.4.1.2 Using a 12d Dongle Number in a 12d Network CodeMeter on page 78.

9.4.1.1 Search for any 12d Network CodeMeter

The simplest entry to add is the one that searches for all 12d Network CodeMeters on the
network.

-

i Add a new dongle = 2
Type |Codemeter - auto network = |
| Select Choice @
— Wibu - local and auto local
[Add ] [F'”'S‘h] [HEIF"] Wibu - network
L Wibu - auto netwaork

Codemeter - local
Codemeter - auto local
Codemeter - network

L=

Codemeter - auto netwu:urb
Pauze

For this case, select CodeMeter - auto network for Type and then click on Add.

A new entry with the default name New dongle is added to the bottom of the list.



12d Model

i Dongles.dd Editor — *
Add | Delete ﬂﬂ
Codemeter Local Type Codemeter - Auta ...
Wibu Local Name New dongle
Newdongie [N - =
-::.:l:Er @
# retries 0

Wait time (seconds) 0.01

| is valid

Write Finish

Click in the Name field and change New dongle to whatever you want, say CodeMeter - auto
network.

The order in the list is the order that 712d Model searches to find a valid dongle.

For example if you want to always search for a local dongle BEFORE the 12d Network
CodeMeter then leave the order as it is.

il Dongles.dd Editor — >
Add | Delete ﬂ
Codermeter Local Type Codemeter - Auto ...
Wibu Local Mame CodeMeter - auto n...
Active true v
CodeMeter - auto network -
FILLEr @
Z retries 0
Wait time (seconds) 001

This is what is normally wanted. That is, use a local dongle if it exists, otherwise use a network
license.

If you want to always search for a 12d Network CodeMeter BEFORE a local dongle then use
the Up arrow icon to move the CodeMeter - auto network to the top of the list. This is rarely
wanted.
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il Dongles.4d Editor — >
Add | Delete ﬂﬂ
CodeMeter - aute network Type Codemeter - Auto ...
Codemeter Local Mame CodeMeter - auto n...
Wibu Local Active true -
ibu Loca —
Fiter @
# retries 0

Wait time (seconds) 0.01

To save the information to the dongles.4d file, press Write to bring up the
Write Setup Flle "dongles.4d" panel.

il Write Setup File "dongles.4d” — >

(" Found folder

(" Current folder

f* Userfolder

ch12d\ 14,000 user

" Other folder

|E:' 4d_documentation12d_V14.00_ Doco’\12d_Model_14 Projects\DE

Write Properties Finish Help

Tick on User folder and then on Write.

For any computer wanting to use a 712d Model license from a 12d Network CodeMeter, the
updated dongles.4d must be placed in the standard search path for the User folder, or in the
folder pointed to by the environment variable USER_4D in env.4d, or is the file pointed to by the
environment variable DONGLES_4D in env.4d.

Using DONGLES_4D means that the dongles.4d file could be on a central computer that can
be accessed by all the other Client computers.

Note:

If you don’t want to search for a Local dongle at all. simply highlight the Local entries and click
on the delete icon to delete them.

WARNING

Projects can have a local dongles.4d file and when the project is selected, the local dongles.4d is
used before any other dongles.4d. If the local file does not have the correct network information
in it then the authorization will fail because 12d Model is no longer being instructed to use the
Network CodeMeter.
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9.4.1.2 Using a 12d Dongle Number in a 12d Network CodeMeter

To point to a particular 12d dongle number, it helps to know the physical CodeMeter number
that the 12d dongle number is in.

If you don’t already know this, the CodeMeter WebAdmin panel can be used to look inside the
Network CodeMeter. See Step 5. Checking the Virtual 12d Virtual Dongles Inside the Network
CodeMeter on page 68.

Note: if you still don’t know what Network CodeMeter the 12d dongle is in, it is possible to find it
when using the Dongles.4d Editor but you will need to look through the list of physical
CodeMeter numbers and see which one contains the required 12d dongle number.

In the Add a New Dongle panel, for the case of using a particular 12d dongle number, select
CodeMeter - network for Type and then click on Add.

-~

ip Add a new dongle = 2

Type |Codemeter - auto network = |
| Select Choice @

Wibu - local and auto local
[Add ] [Finish] Wibu - network

L Wibu - auto netwark
Codemeter - local

Codemeter - auto local
Codemeter - network )
Codemeter - auto network
Pause

A new entry with the default name New dongle is added to the bottom of the list.

i !

il Dongles.dd Editor = 2

E] E] CodeMeter icon

Wibu Local Type Codemeter - Network
Codemeter Local Mame
Active —
New dongle Server name @
# retries ]

Wait time (seconds) 0,01

Click in the Name field and change New dongle to whatever you want but it helps to have the
12d dongle number in the name. For example CodeMeter - ec51470022

Next click on the CodeMeter icon at the end of the Server name field.

This will bring up the CodeMeter Browse panel that searches for all the 12d Network CodeMeters
on the network and for all the 12d dongle numbers in them, and presents the results in a tree.
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-

[ ifl CodeMeter Browse I. = | |_

=- Server Containers i
= Fred.12d.com .
5. 2.2310262 physical CodeMeter number
.. 2= -
- 101956

m

licensequantity(3)
i checkoutduration(d)

= Larry.12d.com
£ 2-2310233
- [©-101956
12d.com
-1 il
4 . . I F

| feRD::a486:b165:933:547 %21,/2-2310278/1

Scroll down the tree until you find the 12d dongle number you are after and click on it.

This will then write what is called the CMUNC to the Server name field.

Aside:

CMUNC is the 12d CodeMeter Universal Naming Convention. An example would be
/[server_name.12d.com/2-2310242/1/16

where server_name is the server name (Fred) with .12d.com added to it, followed by CodeMeter
serial number (2-2310242), then the product code (1), and the final part being the instance within
that product code that contains the 12d dongle number.

Note: The instance can only be found by using the CodeMeter Browse panel.

To save the information to the dongles.4d file, press Write to bring up the
Write Setup Flle "dongles.4d" panel.
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il Write Setup File "dongles.4d” — >

(" Found folder

" Current folder

{» Uszerfolder

ch12d\ 14,000 user

(" Other folder

|E:' 4d_documentation’12d_V14.00_Doce'12d_Model_14_Projects\DE

Write Properties Finish Help |

Tick on User folder and then on Write.

For any computer wanting to use a 712d Model license from a 12d Network CodeMeter, the
updated dongles.4d must be placed in the standard search path for the User folder, or in the
folder pointed to by the environment variable USER_4D in env.4d, or is the file pointed to by the
environment variable DONGLES_4D in env.4d.

Using DONGLES_4D means that the dongles.4d file could be on a central computer that can
be accessed by all the other Client computers.

WARNING

Projects can have a local dongles.4d file and when the project is selected, the local dongles.4d is
used before any other dongles.4d. If the local file does not have the correct network information
in it then the authorization will fail because 12d Model is no longer being instructed to use the
12d Network CodeMeter.

For the updating of nodes.4d, see 9.4.1 Updating dongles.4d on page 73.
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9.4.2 Updating nodes.4d

12d Model will not create new projects or open an existing project without an authorization file
called nodes.4d with valid information in it.

The information inside nodes.4d controls

(a) which 12d dongles are authorized to run 72d Model
(b) what version of 12d Model will run for a 12d dongle

(c) what modules are authorized for a particular 12d dongle

To authorize 72d Model to run with your 12d dongles, a file called nodes.12dxxn where xx is
the 12d Model version number, will have been emailed to you by your local 712d Model Reseller.

For example, for 12d Model 15 the file will be called nodes.712d15n

Cc
Subject: 12D Auth file for 12d Solutions - €c7239002

-] Message | " nodes.12d15n (21 KB}

Modes file for : 12d Solutions
- ec7239002

The authorization file for 12d Model - is attached to this message.

The self-install procedure which follows is for this one workstation and requires 12d Model installed.
After 12d Model version 15 is installed, please double click on the file attachment [nodes.12d15n] to open it and 12d will guide you through.

If this succeeds you do not need to read further.

If this does not work it may be that the mail programme does not allow you to run attachments.
In this case, simply save the attached file to your desktop and open (from the right-mouse menu or by double-click).
This will start the installation for the nodes file.

Instructions for manual Installation:
For version 15 of 12d Model, nodes.12d15n usually goes in the folder
"12d\15.00" and once there it must be renamed to "nodes.4d"

Codemeter dongles require a driver installation which can be obtained here
http://www.wibu.com/en/downloads-user-software.html

If the product is still not authorized after replacing or updating "nodes.4d"
please contact 12D Selutions on (61)(02) 9970 7117 or email sales@12d.com

Installing 72d Model on a computer sets up a Windows file association so that a nodes.712dxxn
file is recognised brings up the Install a 12d Model xx Nodes File panel which is used is to install
a nodes.4d file in the correct location.

In the email, double click on the files nodes.72dxxn and the Opening Mail Attachment panel
comes up.

dongles.4d and nodes.4d Page 81
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Cc
Subject: 12D Auth file for 12d Solutions- ec7239002

-] Message | " nodes.12d15n (21 KB}

Modes file for : 12d Solutions
- ec7239002

The authorization file for 12d My . .
Opening Mail Attachment >

The self-install procedure which

After 12d Model version 15 is ins o You should only open attachments from a trustworthy source, [ Buide you through.

If this succeeds you do not need |

Attachment: nodes. 12d15n from 120 Auth file for 12d
Solutions - COVID-19; Product 12d Model - ec514700f5 -
ec514701el - - Message (HTML)

If this does not work it may be th

In this case, simply savg™

This will start the inst; click on

Open \ih:-uld you like to open the file or save it to your computer?
Instructions for manual Installati
For version 15 of 12d Model, noc Always ask before opening this type of file

"™12d\15.00" and once there it m

Codemeter dongles require a driver installation which can be obtained here
http://www.wibu.com/en/downloads-user-software.html

If the product is still not authorized after replacing or updating "nodes.4d"
please contact 12D Selutions on (61)(02) 9970 7117 or email sales@12d.com

Click on Open and then the Install a 72d Model xx Nodes File panel appears.

‘ﬂ Install a 12d Model 15 Modes File — pod

Install Manage

Source: |C:'-.Users'-Jjg.radunJED WApp Data'-.Lu:ucal'-.Micn:usuﬂ'-.‘.".-'indl:uws'-.lI'~| =

Operation: Prepend bl

Destination: |c:'-.'|2|:|'-.'| 5.00Mnodes . 4d | i3
Install Cancel

The choices for Operation are:

Prepend - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added
to the beginning of the existing nodes file. A backup up copy of the existing nodes.4d is
created THIS IS THE NORMAL CHOICE.

Replace - if a nodes.4d file already exists, it is replaced by a new nodes.4d file with the
information in the nodes.12dxxn file in it. A backup up copy of the existing nodes.4d is
created.

Append - if a nodes.4d file already exists, the information in the nodes.12dxxn file is added
to the end of the existing nodes file. A backup up copy of the existing nodes.4d is created.
THIS IS RARE.

Select Prepend, Replace or Append and then click Install.

The new/updated nodes.4d file is created in the Destination folder (default is C:172d\xx.00) and
if a nodes.4d file already existed, a backup copy of it is made.

Page 82 dongles.4d and nodes.4d
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12d Modes Installer ot
Modes update completed!
Old nodes backed up to: o\ 12d415.00nodes. 3.4d

ﬂ\lote - if you don’t have the file nodes.12dxxn attached to an email but instead have the file in a \

folder accessible from your computer, then you can do the following:

If there is a nodes.12dxxn file, double click on that file and the Install a 12d Model Nodes File panel
should appear and you continue with the instructions above.

If that doesn’t work, start up 12d Model xx and click on the Nodes.4d button at the bottom of the
Open a Recent Project panel. This will also bring up the Install a 12d Model Nodes File panel and you
can browse for the nodes.12dxxn file in the Source panel field. You can then continue with the

Qnstructions above. j

For any computer wanting to use a 712d Model license from a 12d Network CodeMeter, the
updated nodes.4d is then placed in the standard search path for the User folder.

For example, for 12d Model 14 a nodes.4d in c:\12d\14.00, or a file pointed to by the
environment variable AUTHORIZATION_4D in env.4d.

Using AUTHORIZATION_4D means that the nodes.4d file can be on a central computer and
accessed by all the other Client computers.

Now that the dongles.4d file and the nodes.4d file have been updated, any computer on the
network that has the CodeMeter drivers installed and has the updated dongles.4d and nodes.4d
file should be able to obtain a 72d Model license from a Network CodeMeter. That is, it becomes
a 12d CodeMeter Client.

This ends the notes for setting up the 12d CodeMeter Server and any 12d CodeMeter Clients.
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10 CodeMeter Control Center & WebAdmin

The CodeMeter Control Center is used on a particular computer to display which CodeMeters
are on the computer the Control Centre is being run on, to stop and start the CodeMeter
Runtime Server service on the computer, Certify CodeMeters on the computer and to update
the contents of any CodeMeters on the computer. It can also bring up the CodeMeter
WebAdmin panel.

The CodeMeter WebAdmin can do whatever the Control Centre can do but it can work on
CodeMeters on ANY computer that are visible on the network and it has permission to access.

To bring up the CodeMeter Control Center, click on the >
CodeMeter icon that was installed on your task bar.

@ CodeMeter Control Center P
License | Ewvents | Borrow
@ CmStick Marme:
[2-2310242 | '

Serial; 2-2310262

Version: CmStick 2.04

€ =@ [

Capacity: 93 % free (367400 Bytes)

Status: @ @Disabled

@) (g Enabled until unplugged

@ Enabled
License Update Eject Change Passward

CodeMeter is started. )

A

Options under the Process menu can start and stop the CodeMeter Runtime Server service on
the computer. See 10.1 Stopping & Starting the CodeMeter Runtime Server on page 85)

The License Update button is for reporting on, and updating the information about 72d Model
licenses for any CodeMeter (Network or Standalone) attached to this computer. See 10.5
Updating Licenses in Network CodeMeters on page 116).

The WebAdmin button brings up the CodeMeter WebAdmin panel which can display information
about 72d Model licenses for any CodeMeter (Network or Standalone) that is visible on the
computer network. See 10.8 Which Version of WebAdmin? on page 125.
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10.1 Stopping & Starting the CodeMeter Runtime Server

Some changes to CodeMeter configurations on a computer require that the CodeMeter
Runtime Server service is restarted on the computer. In these cases, there is usually a message
to say Changes only take effect after restarting CodeMeter.

The stopping and starting of the CodeMeter Runtime Server on a particular computer can be
done from running CodeMeter Control Center on that computer, or WebAdmin can be used to
stop and start the CodeMeter Runtime Server on any computer that is has access to and
adequate permissions.

See

10.1.1 CodeMeter Runtime Server - Control Centre on page 86
10.1.2 CodeMeter Runtime Server - WebAdmin on page 89

Stopping & Starting the CodeMeter Runtime Server Page 85
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10.1.1 CodeMeter Runtime Server - Control Centre

Click on the CodeMeter icon that was installed on your task bar

to bring up the CodeMeter Control Center.

T

Clicking on the WebAdmin button on the CodeMeter Control Center brings up the CodeMeter

WebAdmin.

For WebAdmin 6:

To stop the CodeMeter Runtime Server service, click on Process >Stop CodeMeter Service

in the CodeMeter Control Center.

@ CodeMeter Control Centor — -

25

File I View Help

Licl O Defragment License Memories |

] @ Update Time Certificates
G @ Repair Hardware Configuration MName:

k) Start CodeMeter Service

© Stop CodeMeter Service

Serial:

ersion:

Capacity:

Status:

Licenze Update

2-2310262

CmStick 2.04

93 % free (367400 Bytes)

@ Disabled
@ (g Enabled until unplugged
i@ @ Enabled

Eject Change Password

€ @ &

CodeMeter is started.

L

You will be asked to confirm that this is to be done.

The CodeMeter Control Center will then reappear with no CodeMeters being found on the
computer and if you look in the Windows Task Manager, the CodeMeter Runtime Server

service will be shown as Stopped.

-
E-_WindowsTaskManager o we L I A B A B B B

s

File Options View Help

|App|iﬁﬁons | Processes | SEMVIces |Performar1c\e INetworking IUsers |

-

MName PID Description Status Group
o _OpOmiea oo _v=. 0, U3 T3 05 T ORI L TIET T aE T R TIoETT T oo T/
CodeMeter.exe CodeMeter Runtime Server Stopped MN/A >
LOMSysApp COM+ System Application Stopped NfA

To start the CodeMeter Runtime Server service, click on Process >Start CodeMeter Service

in the CodeMeter Control Center.
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- ~
@ CodeMeter Control Center — — - — M
File

View Help

Lic Defragment License Memories

Update Time Certificates
No CodeMeter License information available,
There are no CmContainers found.

(%
C

Repair Hardware Configuration

Q Start CodeMeter Service

(m) Stop CodeMeter Service

CodeMeter is stopped. WebAdmin

s F——— = = =

You will be again be asked to confirm that it is to be done.

After a short time, the CodeMeter Control Center panel will then reappear displaying the
CodeMeters on this computer.

@ CodeMeter Control Center | %

License Ewvents Borrow

@ CmStick Name:

2-2310262

Serial: 2-2310262

Version: CmStick 2.04

€ D &

CodeMeter number
Capacity: 93 % free (367400 Bytes)

Status: @ @Disabled

() \&y Enabled until unplugged

@ Enabled
License Update Eject Change Password

CodeMeter is started. WebAdmin

e A

If you look in the Windows Task Manager, the CodeMeter Runtime Server service will be shown
as Running.
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"8 Windows Task Manager

File Options View Help

| Applications | Processes | SErvices | Performance | Metworking | Users |

MName ° PID Description Status Group

dr_ootfimization w40 30319 54 Microsaft MET Framework MGER o Stopped KA

CodeMeter.exe 12464 CodeMeter Runtime Server Running M
R Y=t ala] COMT SyS e Appes o (s u]u<nf TR

Note: There may be more than one CodeMeter attached to the computer. For example

@ CodeMeter Control Center ﬂ

File Process View Help

CodeMeter numbers
—

License Events Borrow

. CmStick

(= Mame:
2-2310262
CmStick
2-2310275 Serial: 2-2310262

Version: CmStick 2.04

€ B~

Capacity: 93 % free (367400 Bytes)

Status: @ @Disabled

() \&y Enabled until unplugged

@ Enabled
License Update Eject Change Password

CodeMeter is started. WebAdmin

Warning: Access to all the CodeMeters on the computer is stopped by stopping the CodeMeter
Runtime Server service.
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10.1.2 CodeMeter Runtime Server - WebAdmin

To bring up the CodeMeter WebAdmin panel, click on the WebAdmin button on the CodeMeter
Control Center.
For WebAdmin 6:

For instructions on how to select and see CodeMeters on a particular Network Server, see
10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 103

Once the required Computer is selected in the CodeMeter WebAdmin panel, to stop the
Network Server, click on the Configuration >Server >Server access menu, then select
Disable and finally click on Apply.,

- & WebAdmin | Server Access b + - O
e

c ‘@‘ ® localhost:22350/configuration/server_access.html e 1:? N @

LJIBU CodeMeter WebAdmin C

SYSTEMS

Dashboard Container v  License Monitoring v  Diagnosis v [JE@elsiile[sg-1uls]s I

E Server Configuration Server Access Basic 5 (2] B English (US)
Server Access License Access Permissions ( Server > Server Access )
—Network Server Advanced License Access Permiss
@ Disable
O Enable

—CmWAN Server
O Disable

® Enable
CmMWAN Port *: 22351 |

‘ Apply ) Restore Defaults

(*) Changes only take effect after restarting CodeMeter

The CodeMeter Control Center will then reappear with no CodeMeters being found on the
computer and if you look in the Windows Task Manager, the CodeMeter Runtime Server
service will be shown as Stopped.

-
E’ Windows Task Manager .. m e Frw '_“'. - e

File Options View Help

| Applications | Processes | Services |Perﬁ:rmance I Metworking I Users |

Mame = PID Description Status Group

dr_optimization w4.0.30319 64 Microsoft NET Framework MGER Stopped BIiA

CodeMeter.exe CodeMeter Runtime Server Stopped M/ )
FCOMGysADD COM T GysStem Appicanan Ctopped A

To start the CodeMeter Runtime Server service, click on the Configuration
>Server >Server access menu, then select Enable and finally click on Apply
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- & WebAdmin | Server Access b + - O
&« ( ‘@‘ ® localhost:22350/configuration/server_access.html e 1:? N @
WiBU CodeMeter WebAdmin C
SYSTEMS

Dashboard Container ~+  License Monitoring v  Diagnosis v [E@elsiile[sg-1uls]s 1%

E Server Configuration Server Access Basic N (2] B English (US)

Server Access License Access Permissions ( Server >| Server Access )

—Network Server Advanced License Access Permiss

O Disable

MNetwork Port *: 22350

—CmWAN Server
O Disable

® Enable
CmMWAN Port *: 22351 |

pply Restore Defaults

(*) Changes only take effect after restarting CodeMeter

You will be again be asked to confirm that it is to be done.

If you look in the Windows Task Manager, the CodeMeter Runtime Server service will be shown
as Running.

I'-; Windows Task Manager

File Options View Help

| Applications | Processes | Services | Performance | Metworking | Users |

MName ° PID Description Status Group
dr_optimization v4.0,30319 54 Micr
( CodeMeter.exe 12464 CodeMeter Runtime Server Running M
LG YT aa) T T Sy e e Appea tan Sroppen e

Warning: Access to all the CodeMeters on the computer is stopped by stopping the CodeMeter
Runtime Server Service.
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10.2 Port Address for CodeMeter Communication

For CodeMeter WebAdmin 6, see 10.2.1 Port Address - WebAdmin 6 on page 91
For CodeMeter WebAdmin 5, see 10.2.2 Port Address - WebAdmin 5 on page 92.

10.2.1 Port Address - WebAdmin 6

The CodeMeter License Server uses a specific IP port (defaulted on 22350) to communicate
with your computer and the network. This network port is registered at IANA (Internet Assigned
Numbers Authority) and is uniquely assigned for CodeMeter® communication.

Please make sure that your firewall is not blocking this port.

Enable the used IP port 22350 and make sure it is accessible by CodeMeter®, i.e. share the
communication for this IP port.

The IP port used for communication can be changed by the CodeMeter WebAdmin panel.

Click on the Configuration >Server >Server access menu.

&« ( ‘@‘ ® localhost:22350/configuration/server_access.html e 1:? N @ =

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container ~+  License Monitoring v  Diagnosis v [E@elsjile[sg-1uls]s I

E Server Configuration Server Access Basic 5 (2] B English (Us) ~
Server Access License Access Permissions ( Server > Server Access )
—Network Server Advanced License Access Permis
O Disable
@ Enable
~
Network Port *: 22350
_

—CmWAN Server
O Disable

® Enable
CmMWAN Port *: 22351 |

Restore Defaults

(*) Changes only take effect after restarting CodeMeter

Change the Network Port: field to the number of the port that you want the CodeMeter to
communicate over, and then press Apply.

Important: For the change to take affect, you need to stop and then restart the CodeMeter
Runtime Server service. See 10.1 Stopping & Starting the CodeMeter Runtime Server on
page 85.
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10.2.2 Port Address - WebAdmin 5

The CodeMeter License Server uses a specific IP port (defaulted on 22350) to communicate
with your computer and the network. This network port is registered at IANA (Internet Assigned
Numbers Authority) and is uniquely assigned for CodeMeter® communication.

Please make sure that your firewall is not blocking this port.

Enable the used IP port 22350 and make sure it is accessible by CodeMeter®, i.e. share the
communication for this IP port.

The IP port used for communication can be changed by the CodeMeter WebAdmin panel.

Click on the Configuration >Server tab.

CodeMeter WebAdmin C\/J

Server

Bind Address: All (Default)

Run Metwork Server: [

(Network Port *: |2235I} D

Run CmWAN Server: [

CmWAN Port *: |22351 |

| Apply || Default |

(*) Changes only take effect after restarting CodeMeter

Change the Network Port: field to the number of the port that you want the CodeMeter to
communicate over, and then press Apply.

Important: For the change to take affect, you need to stop and then restart the CodeMeter
Runtime Server service. See 10.1 Stopping & Starting the CodeMeter Runtime Server on
page 85.
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10.3 Certifying CodeMeters

Updating the Certified Time in a CodeMeter must be done at least every two month over the
Internet and Certifying needs communication between the CodeMeter and a Certified Wibu
Time Server.

So for Certification to occur, a computer that can access the CodeMeter must also have access
to the Internet at least every two months so it can run the Certification.
Certifying a CodeMeter can be done
(a) manually from inside 12d Model itself
See 5.1 Certifying CodeMeters from 12d Model on page 42
(b) automatically by 712d Model
See 5.2 Automatically Certifying CodeMeters from 12d Model on page 44

(c) outside of 72d Model when the CodeMeter is on the computer you are using outside

Using the CodeMeter Control Centre - see 5.3 Certifying CodeMeters Using Control
Center on page 45.

or

(d) outside 712d Model when the CodeMeter is NOT on the computer your are using

It is possible to certify CodeMeters that are on other computers but this is usually only
needed by Administrators. See 10.3.1 Certifying CodeMeters Using WebAdmin on page 94

Important Note

To display and update the Certified Time in the CodeMeter, you need access over the Internet
to a CodeMeter Time Server (see 10.3.2 Time Servers for Certified Time on page 100) and this
Internet communication must be allowed to be done through an IP port (see 9 Network
CodeMeters on page 59).

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Certifying CodeMeters Page 93
e = = = > <= 7 —Z
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10.3.1 Certifying CodeMeters Using WebAdmin

If the CodeMeter is NOT attached to your current computer you need to use the
CodeMeter WebAdmin panel which is brought up by clicking on the WebAdmin button on the

CodeMeter Control Center.

@ CodeMeter Control Center

File Process VWiew Help

License Events

Mo CodeMeter License information available.
Mo CmContainer found.

CodeMeter is started. WebAdmin

For CodeMeter WebAdmin 6, see 10.3.1.1 Certifying CodeMeters Using WebAdmin 6 on

page 95
For CodeMeter WebAdmin 5, see 10.3.1.2 Certifying CodeMeters Using WebAdmin 5 on
page 99.

Page 94 Certifying CodeMeters
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10.3.1.1 Certifying CodeMeters Using WebAdmin 6
After getting up CodeMeter WebAdmin panel up, on the Dashboard you need to set the Current
Server to the server that the CodeMeter is on.
To get a list of servers, click on the Current Server: field at the bottom of the Dashboard and you
will get a list of the servers found.

c o @ localhost:22350/indexhtml - ¥ W @ =

ls.;lsl%% CodeMeter WebAdmin C

Configuration v~

BEELEIGGI Container v License Monitoring v Diagnosis v

@R Dashboard (2] EE English (US) ~

Current Server: RanchDocco
IP-Address: 151

Operating System:  Microsoft Windows 10 Enterprise, 64-Bit
Server Startup: 2018-11-18 05:35:43

Server Version: Version 6.30a of Jul/28/2016 (Build 2266)

Runtime Version: 6.30a

WebAdmin Version: 6.30

Current Server: localhost (127.0.0.1)
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N @ =

@ localhost:22350/indexhtml e O

Server found:

localhost (127.0.0.7)

-nas.lzd.com (_. 10)

Il :<rver.12d.com (192.168.68.252)

O Use IP-Address

If there is more than one CodeMeter on that computer/server, select the one that you want to
examine and click on Apply.

The information about the selected Server will be displayed, including any CodeMeters that are
found on the server and the current sessions on them.

. & WebAdmin | Dashboard x B - O
&« ¢ o ® server.12d.com:22350/index.html - @Y mn @o =

CodeMeter WebAdmin Cr

SYSTEMS

Dashboard Container ~  License Monitoring v  Diagnosis v Configuration v Info

@B Dashboard (7] B English (US) ~

Sessions (2)

Current Server: SERVER

- . 12d Model - Stock
IP-Address: 252 docco.12d.com .1011956 - 12d Solutions - e
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit : c51470112
Server Startup: 2018-10-15 16:28:48 Lo105s 12 Model - Stock
Server Version: Version 6.40a of Dec/22/2016 (Build 2402) docco.12d.com 7y ;:5112‘?75;"1?'“”5 - ®
Runtime Version: 6.40a

Current Server JJlISERVER (_252) : WebAdmin Version: 6.40

If there is more than one CodeMeter (CmContainer) on that computer/server, select the one
that you want by Walking right on the Container menu.
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CodeMeter WebAdmin

SYSTEMS

DEFGLGEIGE Container ~  License Monitoring v Diagnosis v Configuration ~  Info
@R Dashboard Al Container s | <no name> 2-1387203 (7]
(cno name>  2-2310233 )
<no name> 2-2310242 -
. Sessions (2)
Current Server: Bl choname>  3-4025920 )
_ . 12d b
IP-Address: 68.252 docco.12d.com }011955 T2
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit : c514%
Server Startup: 2018-10-15 16:28:48 d
d 12d 101556 -1212:;~
Server Version: Version 6.40a of Dec/22/2016 (Build 2402) occa.lzd.com .y o
Runtime Version: 6.40a
Information about the selected CodeMeter is then displayed.
Click on the CmContainer Info button to expand the information displayed.
. @ WebAdmin | Container b + - O
<« c Q @ server.12d.com:22350/container/cmcontainer_details.html?BoxSerial=2-2310233 e @ ﬁ N @

CodeMeter WebAdmin C

SYSTEMS

Dashboard Container v License Monitoring + Diagnosis v Configuration v  Info

I Al Container  <no name:> (2-2310233)

B <no name> 2-2310233 CmStick 2.04

Q
‘ A Licenses CmContainer Info Backup & Restore

e B English (US)

A 100003 Bundling Articles

Product Code Name Unit Counter WValid Until License Quantity Feature Map
1 SecurikKey Lite nfa nfa 1 0Oxl

A 101956 12d.com

Product Code Name Unit Counter WValid Until License Quantity Feature Map
1 12d Model - Stock - 12d Solutions - ec51470113 nfa nfa 5 nfa
1 12d Model - Stock - 12d Solutions - ec51470114 nfa nfa 25 nfa

current Server: [IIllserver (N 252) % i WebAdmin Version: 6.40

The current Certified time for that CodeMeter will be displayed.
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The Certified time for that CodeMeter can be updated to the current date by clicking on the
Update button.

. @ WebAdmin | Container b + - O
e

&

Q O] server.12d.com:22350/container/cmecontainer_details.html?BoxSerial=2-2310233 e @ ﬁ In @

CodeMeter WebAdmin C

SYSTEMS

Dashboard

Container ~ License Monitoring +~ Diagnosis ~ Configuration v Info

E All Container <no name> (2-2310233) (2] B English (US) ~

<no name> 2-2310233 CmStick 2.04 .
ﬁ Licenses # CmcContainer Info Backup & Restore
Name <no name>
Serial Number 2-2310233
CmContainer Type CmStick 2.04 click to update the
First Device I: (No Flash) Certified time
Status @ Enabled
System Time (PC) 2018-12-23 16:22:51
System Time (CmContainer) 2018-12-23 16:22:48
( Certified Time (CmContainer) 2018-12-05 14:55:29 ) O
Free Memory

current Server: | lISERVER (_.252) b : WebAdmin Version: 6.40

If you have permission to do so, the Certified time for that CodeMeter can be updated to the
current date by clicking on the Update button.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Important Note

To display and update the Certified Time in the CodeMeter, you need access over the Internet
to a CodeMeter Time Server (see 10.3.2 Time Servers for Certified Time on page 100). This
Internet communication is through a set IP port (see 9 Network CodeMeters on page 59).
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10.3.1.2 Certifying CodeMeters Using WebAdmin 5

After getting up CodeMeter WebAdmin panel up, on the Home tab set the Host Name: field to the
name of the computer or server that the CodeMeter to be certified is on, and then go to the
Content >CmContainer tab.

CodeMeter WebAdmin C\/J

Home S e - Diagnosis H
Licenses User Data Backup/Restore
CmContainer: [2-2310278 [v]
Name: <No name:
CmContainer Type: CmStick 2.04
First Device: Mo drive assigned {HID)
Status: Ooisabled
Certified time Enabled until Unplugged CIICk. t.O Up_date the
Certified time
EEnabled
System Time (PC): 2015-09-03 17:40:47 /
System Time (CmContainer): 2015-09-03 17:40:47

(Certifl'ed Time (CmContainer): 2015-09-03 1?‘:13:38) ( Update )
Free Memory: 93 % (367.432 Bytes) Defragment

If there is more than one CodeMeter (CmContainer) on that computer/server, select the one
that you want to examine in the CmContainer: field.

The Certified time for that CodeMeter can be updated to the current date by clicking on the
Update button.

Please contact your 12d Model Reseller if you are having problems certifying your CodeMeter.

Important Note

To display and update the Certified Time in the CodeMeter, you need access over the Internet
to a CodeMeter Time Server (see 10.3.2 Time Servers for Certified Time on page 100). This
Internet communication is through a set IP port (see 9 Network CodeMeters on page 59).
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10.3.2 Time Servers for Certified Time

When you certify a CodeMeter it searches the internet for a CodeMeter Time Server to update
the Certified Time in the CodeMeter.

For CodeMeter WebAdmin 6, see 10.3.2.1 Time Servers - WebAdmin 6 on page 100
For CodeMeter WebAdmin 5, see 10.3.2.2 Time Servers - WebAdmin 5 on page 101.

10.3.2.1 Time Servers - WebAdmin 6

For a particular CodeMeter on a Server, the Internet or IP addresses of the CodeMeter Time
Servers that are searched to set the Certified Time are given in the Configuration >Certified
Time tab of the CodeMeter WebAdmin panel.

€% WebAdmin | Container Pl & WebAdmin | Dashboard b + - m]
& (& Q‘ ® server.12d.com:22350/index.html e @ i:? i &
CodeMeter WebAdmin C

SYSTEMS

BEEFLLEIGE Container ~  License Monitoring v Diagnosis v Configuration ~  Info x

@B Dashboard

Basic » © = English (US)
Server > =
Current Server: SERVER ( ad g LTS ()]
vance:

. . 12d Model - Stock
IP-Address: 292 docco.12d.com _1011955 - 12d Solutions - e
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit ' c51470113
Server Startup: 2018-10-15 16:28:48
Server Version: Version 6.40a of Dec/22/2016 (Build 2402)

Runtime Version: 6.40a

The list of Time Servers used for this CodeMeter are then displayed.

CodeMeter WebAdmin

SYSTEMS

Dashboard  Container ~  License Monitoring ¥~  Diagnosis ~ [JESslalils[Vg-1ile]1g

i:[g Advanced Configuration Time Server

Time Server Extra

FTime Server \

1. cmtime.codemeter.com

2. cmtime.codemeter.us
3. cmtime.codemeter.fr

4. cmtime.codemeter.de

Time Out: 20 Seconds

&

The Time Servers list is searched in order from the top to the bottom.

Page 100 Certifying CodeMeters
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Servers in the list are added or removed using the add or remove buttons, and a highlighted entry
in the list is moved up or down with the up and down buttons.

Clicking Apply saves these entries in the Windows Registry of the Server that the CodeMeter is
on.

10.3.2.2 Time Servers - WebAdmin 5

For a particular CodeMeter on a Server, the Internet or IP addresses of the CodeMeter Time
Servers that are searched to set the Certified Time are given in the Configuration >Certified Time
tab of the CodeMeter WebAdmin panel.

CodeMeter WebAdmin C\/J

Configuration

Diagnosis

Certified Time

MNetwork Server Proxy Access Control WebAdmin Backup Borrowing

Certified Time

Time Server: |cmtime.codemeter.com
cmtime.codemeter.us
cmtime.codemeter.fr
cmtime.codemeter.de

| add || remove || up || down |

Time QOut: sec

| Apply || Default |

The Time Servers to search are given in the list labelled Time Server: and the list is searched in
order from the top to the bottom.

The Timer Servers can be specified by either an Internet address or an IP address.

Servers in the list are added or removed using the add or remove buttons, and a highlighted entry
in the list is moved up or down with the up and down buttons.

Clicking Apply saves these entries in the Windows Registry of the Server that the CodeMeter is
on.
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10.4 Monitoring and Cancelling Licenses

Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display
information about 712d Model licenses for any CodeMeter (Network or Standalone) that is visible
on the computer network.

For instructions on finding information about CodeMeters on a particular Network Server, see

10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 103
10.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 110.
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10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6

Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display
information about 712d Model licenses for any CodeMeter (Network or Standalone) that is visible
on the computer network.

The panel comes up with the Dashboard tab displaying information about one of the
CodeMeters on this computer.

To get information about CodeMeters on another Server, you need to set the Current Server to
the server that you wish to exam CodeMeters on.

To get a list of servers, click on the Current Server: field at the bottom of the Dashboard:

c @ @ localhost:22350/indexhtml o @ 1y N @ =

CodeMeter WebAdmin C

SYSTEMS

BEELLLEIGE Container ~  License Monitoring ~  Diagnosis ¥ Configuration ~  Info <

@B Dashboard © = English (Us) ~
Current Server: Docco
IP-Address: 151
Operating System:  Microsoft Windows 10 Enterprise, 64-Bit
Server Startup: 2018-11-18 05:35:43
Server Version: Version 6.30a of Jul/28/2016 (Build 2266)
Runtime Version: 6.30a

Current Server: localhost (127.0.0.1) % WebAdmin Version: 6.30
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@ localhost:22350/index.html o @ Ty m o =

If there is more than one CodeMeter on
that computer/server, select the one that
you want to examine and click on Apply.

Server found:

localhost (127.0.0.7)

Il =5 12d.com (R 10)
Ilsrver.12d.com (I 252

O Use IP-Address

Important Note:
It is possible to have different versions of WebAdmin installed on different Servers.

So depending on which Server you are looking at, you may now need to swap between the
notes for WebAdmin 6 and WebAdmin 5.
For instructions on Monitoring and Cancelling Licenses on this Server, see

10.4.2 Monitoring and Cancelling Licenses - WWebAdmin 6 on page 105
10.4.4 Monitoring and Cancelling Licenses - WebAdmin 5 on page 112.
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10.4.2 Monitoring and Cancelling Licenses - WebAdmin 6

The information about a selected Server will be displayed, including any CodeMeters that are
found on the server and the current sessions on them.

Dashboard

SYSTEMS

@B Dashboard

Current Server:
IP-Address:
Operating System:
Server Startup:
Server Version:

Runtime Version:

® server.12d.com:22350/index.htm!

CodeMeter WebAdmin

Container ~ License Monitoring ~ Diagnosis v Configuration ~ Info

(2] B English (US) ~

SERVER Sessions (2)

.252
Microsoft Windows Server 2012 R2 Standard, 64-Bit
2018-10-15 16:28:48
Version 6.40a of Dec/22/2016 (Build 2402) docco.12d.com
6.40a

docco.12d.com

101956
1

101956
1

12d Model - Stock
- 12d Solutions - e
C51470113

12d Model - Stock
- 12d Solutions - &
C51470113

To find out information about all the CodeMeters (CmContainer) on that computer/server, select
the Container >All Containers option, and expand the 12d Model product code 101956 for

each CodeMeter to show any virtual 12d dongles in a CodeMeter or any standalone
CodeMeters.
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&«

The example below shows a Server with three CodeMeters attached to it: one with a single
virtual 12d dongle, one with two virtual 12d dongles and one which is a standalone CodeMeter.

(@ WebAdmin | Container b 1+

C* WebAdmin | License Monito!

c @

server.12d.com:22350/container.ntml

- @ 1

I |W|I2IF Dashboard [EEGHICILEIRGE License Monitoring v Diagnosis v Configuration v Info
SYSTEMS

i All Container

v 99 Firm Security Box Item
~ 100003 Bundling Articles
v 100021 WIBU-SYSTEMS AG

C1 2d Model product code)

<no name>

2]

=]

I @
£

English (US)

\ CodeMeter numbers) bt

@Y
G A Licenses CmCaontainer Tnfn Backin and Beatar,
two virtual 12d dongles in the one CodeMeter
v 0003 Bunrmrg—oroen
Product C; T Unit Counter

1 12d Model - Stock - 12d Solutions - ec51470113

1 12d Model - Stock - 12d Solutions - ec51470114

2-2310242

Backup and Restore

<no name:>

A Licenses CmContainer Info

&
e

CmStick 2.04

5
25

n/a

nia

License Quantity Feature Map

v 100003 Bundling Articles

(one 12d Model virtual dongle in a CodeMeter >

A 101956 12d.com

Product Code Name Unit Counter WValid Until License Quantity Feature Map
1 12d Model - 12D Solutions - NSW - ec51470101 nfa nfa 3 nfa
Cone standalone 12d Model CodeMeteD
<no name:> 3-4025920 CmStick 4.01
&
[ . .
& M Licenses CmContainer Info Backup and Restore
~ 101956 12d.com

Product Code Name Unit Counter

1 12d Model - 12d Solutions - 5c2d470acl nia

%

Valid Until

n/a

WebAdmin Version: 6.40

1

nia

License Quantity Feature Map

v

Current Server: -SE RVER (-252)
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If there is more than one CodeMeter (CmContainer) on the computer/server, information about
just one of them can be obtained by walking right on the Container >All Container menu and
selecting the required CodeMeter number.

<« ¢ @ @ server.12d.com:22350/index htmi - T

SYSTEMS

Dashboard [EeGhEYal=Ig% License Monitoring v Diagnosis v Configuration v Info

@R pashboard Al Container » | <no name> 2-1387203 @ =:
(<no name>  2-2310233 )
<no name> 2-2310242

Sessions (2)

Current Server: SE <noname>  3-4025920 o
- . 12d Model -
IP-Address: 8.292 docco.12d.com .1011955 - 12d Solut
Operating System:  Microsoft Windows Server 2012 R2 Standard, 64-Bit ’ c51470113
Server Startup: 2018-10-15 16:28:48 L0105 12d Model -
[P : f docco.12d.com | - 12d Solut
Server Version: Version 6.40a of Dec/22/2016 (Build 2402) T 1 1470113
Runtime Version: 6.40a

Information about the selected CodeMeter is then displayed. Expanding the 12d Model product
code 101956 will show any virtual 12d dongles in a CodeMeter.

. & WebAdmin | Container b + - O
e

(&) Q ® server.12d.com:22350/container/cmcontainer_details.html?BoxSerial=2-2310233 e @ i:? N B

CodeMeter WebAdmin C

SYSTEMS

L Ll Container ~ License Monitoring ~  Diagnosis ~  Configuration ~  Info

E All Container <no name> (2-2310233) (2] B English (US)
<& <no name> 2-2310233 CmStick 2.04 .

Q
‘ M Licenses CmContainer Info Backup & Restore

A 100003 Bundling Articles
Product Code Name Unit Counter Valid Until License Quantity Feature Map

1 SecuriKey Lite nfa n/a 1 0Ox1i

A 101956 12d.com

Product Code Name Unit Counter Valid Until License Quantity Feature Map
1 12d Model - Stock - 12d Solutions - ec51470113 nfa n/a 5 n/a
1 12d Model - Stock - 12d Solutions - ec51470114 nfa n/fa 25 nfa

Current Sewer:-SERVER (I > 52) % - WebAdmin Version: 6.40

And as discussed in the Certifying section, clicking on the CmContainer Info button expands the
information displayed for the CodeMeter.
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To see information about the total number of licenses available for each virtual 12d dongle, and
the number of licenses currently being used and how many are left to use, click on the
License Monitoring >All Licenses menu.

@ WebAdmin | Container
&« (D Q @ server.12d.com:22350/container/cmcontainer_details.htm|?BoxSerial=2-2310233 e @ T.‘? I @

CodeMeter WebAdmin C

SYSTEMS

Container ~ License Monitoring ~ Diagnosis v Configuration ~ Info

% All Licenses

Sessions
& <no name:» 2-2310233 CmStick 2.04 .
(8]

Dashboard

E All Container <no nam (2] B English (US) ~

Licenses A CmContainer Info Backup & Restore

Name <no name>

Information about the selected CodeMeter is then displayed.

. @& WebAdmin | License Monitorin X [iae
&« c @® server.12d.com:22350/license_monitoring.html [ R d In O =

LJIBU CodeMeter WebAdmin C

SYSTEMS

Dashboard  Container v (ERERERUGLIIGIEL) M Diagnosis ¥ Configuration ~  Info

":‘ All Licenses (2] B English (US) ~
Available Licenses on SERVER

v 10 CodeMeter Test Firm Code

v 99 Firm Security Box Item

v 100003 Bundling Articles
v 100021 WIBU-SYSTEMS AG

A 101956 12d.com

Product Code * Name Feature Map License Quantity Used Available
1 12d Model - 12D Solutions - NSW - ec51470101 - 3 0 3
1 12d Model - Stock - 12d Solutions - ec51470113 - 5 2 3
1 12d Model - Stock - 12d Solutions - ec51470114 - 25 0 25
1 12d Model - 12d Solutions - 5c2d470acl - 1 0 1
Page 108 Monitoring and Cancelling Licenses
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. & WebAdmin | License Monitorir X [ias
<« & Q @ server.12d.com:22350/license_monitoring.html v f? i @ =

CodeMeter WebAdmin C

SYSTEMS

Dashboard  Container ~ ERCGEERUGLIIGIELIIEEN Diagnosis ~  Configuration ~  Info

"&"' All Licenses (2] = English (US) ~

@umber of licenses fre;

Available Licenses on 'BUILD-SERVER’

v 10 CodeMeter Test Firm Code

(one 12d Model virtual dongle in a CodeMeter >

v 100003 (two 12d Model virtual dongles in a CodeMeter >
v 100021 WIBU-SYHTEMS AG Number of licenses on
A 101956 12d.co each virtual 12d dongle J

@umber of licenses being usecD

Product Code * Name Feature Map License Quanti Used Available
1 12d Model - 1yPp Solutions - NSW - ec51470101 - 3 0 3
1 12d Model - Stock - 12d Solutions - ec51470113 - 5 2 3
1 C2d Model - Stock - 12d Solutions - ec5147UIID - 25 0 25
1 12d Model - 12d Solutions - 5c2d470acl - 1 0 1

Information last updated on 2018-12-25 11:29:20

Clicking on the Product Code 1 for a CodeMeter showing some licenses are being used will (for
example ec514470113), displays the user name of the user of each license (session).

If you have the required permission, the session can be terminated by selecting Cancel at the
end of the session row and in the Action column.

server.12d.com:22350/license_monitoring/license_monitoring_details.htm!? - O i i@ =

CodeMeter WebAdmin C

C* WebAdmin | License Monito,

c @

< ®

SYSTEMS

Dashboard  Container ~ JERREGEERIGNIGGGIEE Diagnosis ~  Configuration ~  Info

85 AlLicenses - <no name> (2-2310233) - Entry 101956:1 (-) © = Eenglish (US) ~

License Monitoring Details @Ser for the sessiorD

Glick to Cancel the sessioa

CmContainer Availatse Total

<no name:> (2-2310233) 101956:1 (-)

Client Application Access
Process ID Information Mode

] Client (User) First Access Last Access Expires Action

151 ( 2018-12-25 2018-12-26
151 ( - 2018-12-25 2018-12-26
220 Candice) 0 User Limit 08:39:53 12:10:35

Information last updated on 2018-12-26 12:11:17
WebAdmin Version: 6.40
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10.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5

Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display
information about 72d Model licenses for any CodeMeter (Network or Standalone) that is visible
on the computer network.

The panel comes up with the Content >CmContainer tab displaying information about one of
the CodeMeters on this computer.

CodeMeter WebAdmin C\/.I

onfiguration

Licenses User Data Backup/Restore

Diagnosis

CmContainer: [2-2310278 [v]
Name: <no name:
CmContainer Type: CmStick 2.04
First Device: Mo drive assigned (HID)
Status: Ooisabled
Enabled until Unplugged

EEnabled

System Time (PC): 2015-08-14 17:24:11

System Time (CmContainer): 2015-08-14 17:24:10

Certified Time (CmContainer): 2015-08-14 15:36:01 Update
Free Memory: 93 % (367.432 Bytes) Defragment

CodeMeters on other computer can be examined by clicking on the Home tab and then clicking
on the displayed Host Name: to bring up the panel to select a Server to check for CodeMeters.

A pop up list is automatically created of all the computers that are visible on the network and
have CodeMeters on them.
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CodeMeter WebAdmin C‘v]

Y Home | onten Server Configuration Diagnosis nfo Help
Host Name: Americiure ~
2 CodeMeter | WebAdmin - Internet ... l = éj
IP Address: -6 |E http://localhost:22350/5electServer.html |
Operating System: Microsoft \ p01), 64-bit
CodeMeter Web Administration
Server Startup: Aug/13/20
P 9/13/ Select a Server

A

Runtime Version: 5.10b |Iocalhost (127.0.0.1) —I
= . [ use 1P Address

Server Version: Version 5.

WebAdmin Version: Version 5.

Intranet settings are turned off by default.

Picking a Server/Computer from the list and then pressing Select will set the Host Name: to the
selected computer and all the tabs on the CodeMeter WebAdmin panel will then show information
about the CodeMeters on the selected computer.

Important Note:
It is possible to have different versions of WebAdmin installed on different Servers.

So depending on which Server you are looking at, you may now need to swap between the
notes for WebAdmin 6 and WebAdmin 5.
For instructions on Monitoring and Cancelling Licenses on this Server, see

10.4.2 Monitoring and Cancelling Licenses - WebAdmin 6 on page 105
10.4.4 Monitoring and Cancelling Licenses - WebAdmin 5 on page 112.
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10.4.4 Monitoring and Cancelling Licenses - WebAdmin 5
The tab Content >Licenses will display information about any selected CodeMeter on the
selected computer.

CodeMeter WebAdmin \Y |

Home Content Server Con guatlon Diagnosis Info Help
CmContaineUserData Backup/Restore
CmContainer: [2-2310233 [v]

100002 | Bundling Articles

Product Norme Unit Expiration Activation License
Code Counter Time Time Quantity
3l SecuriKey Lite n/a nfa nfa 1

101956 | 12d.com

Product Name Unit Expiration Activation License
Code Counter Time Time Quantity
12d Model - Stock - 12d
1 Solutions - ec51470113 n/a a a >
1 12d Model - Stock - 12d T NTE n/a 25

Solutions - ec51470114

To see how many 12d Model licenses are being used by each virtual 12d dongle in all the
CodeMeters on a particular Server, when that server has been selected on the Home tab, click

on the Server >User tab.
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CodeMeter WebAdmin |
Server Configuration Diagnosis Info Help

Cluster User

Available Network Licenses at '"BUILD-SERVER'

[HITIE Name Eeatuee Licenses Status
Code Map

S No
User Limit lieor Ex_clu— Shaced | ‘Fice
(Borrowed) | . . sive

Limit

10 | CodeMeter Test Firm Code

13 Test Entry = 1 0(-) 0 0 0 1
CmbDemo I K
for C++ (one 12d Model virtual dongle in a CodeMeter 2:|
etails
|

1608 created this -
Product | | | | |

[
ftem / ("two 12d Model virtual dongles in a CodeMeter )

/ ﬁl]1956 | 12d.com

12d Model - .
12% © ‘Z ~ Number of licenses on \K
1 | Solutions - - 3 each virtual 12d dongle [
MNSW -
ec51470101 . /
12d Model - lé/
Stock - 12d -
1 Solutions - 5 2(-) 0 0 0 3
ec51470113
12d Model - id
Stock - 12d H .
I R 25 @umber of licenses frea 25
ec51470114 N I I I \_/

Information last updated on Aug/14/2015 19:47:58

The 12d dongles are displayed under the section titled 101956 | 12d.com.

The table also displays how many 712d Model licenses are on each 12d dongles, and how
many of those licenses are still Free to be used.

Details about each user on a particular 12d dongle is displayed by clicking on the Details button
at the end of the row for that virtual 12d dongle.
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Cluster User

CodeMeter WebAdmin
Server Configuration

Diagnosis  Info

License Details CmContainer 2-2310233

Help

Entry 101956 : 1 (-)
Free 3
Total 5
Client Sl =
o Applicati Acce First Last = =
ID | Client (User) | Process P aon 5% e o Expires | Action
D Information | Mode Access Access
2015-08- | 2015-08-
229 | (13600-1 \Ialll; 2 ik 19 L
g 19:41:48 | 19:49:22
2015-08- | 2015-08-
22| (13600-1\aig) | Limit i i
g 19:41:57 | 19:48:15
Information last updated on Aug/14/2015 19:49:25

A particular user session of 12d Model can be stopped by clicking on the Cancel button.

A Confirmation panel will then be brought up.

-

If you click on OK and have permission to be able to stop people, the session will be terminated.

L%

Message from webpage

=2

:I Do you really want to delete User '220° {

1177

QK

| | cancel

o

If you do not have permission, you will get the message
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WebAdmin CodeMeter C\d

Home Content Server Configuration Diagnosis Info

HTTP ERROR 403

The access to the CodeMeter Server was not permitted,
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10.5 Updating Licenses in Network CodeMeters

A Network CodeMeter can contain one or more virtual 12d dongles and each of these virtual
dongles can have a different number of 72d Model licenses.

Adding extra 12d dongles, or modifying the number of licenses on each of the 12d dongles can
be done electronically without having to remove the Network CodeMeter from the computer.

Updating virtual 12d dongles is usually one simple step but it may involve two steps.

Step 1.Generating the CodeMeter Context File (WibuCmRaC) - only if asked for

The context (.WibuCmRaC) file holds information about the current settings in the Network

CodeMeter. 12d Solutions usually knows these setting for your Network CodeMeter and
this step is normally not required.

However sometimes you may be asked to generate the .WibuCmRaC file and email it to
your local 12d Model Distributor.

If you need to generate the .WibuCmRacC file, go to 10.5.1 Generating the Context File
(.\WibuCmRac) on page 117.

Step 2.Updating the Network CodeMeter with the .WibuCmRaU file

You will be emailed one or more special files (ending in .WibuCmRaU) which are used to
update the information about the virtual 12d dongles in the Network CodeMeter.

If you have a WibuCmRaU file, go to 10.5.1.1 Updating Using the .WibuCmRaU File on

age 120.
Page 116 Updating Licenses in Network CodeMeters
= = = L 7 X
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10.5.1 Generating the Context File (. WibuCmRac)

The follow steps will generate a new context file for a Network CodeMeter using the CodeMeter
Control Center panel.

The CodeMeter Control Center panel is accessed by clickingon —— g
the CodeMeter icon that was installed on your task bar.

(& CodeMeter Control Center g

License Events Borrow

@ Cm5Stick Name:

2-2310262
[2-2310242 ]

Serial: 2-2310262

Version: CmStick 2.04

@ [~

Capadity: 93 % free (367400 Bytes)

Click on License Status: @ () Disabled
Update (2 (2 Enabled until unplugged
© (& Enabled

License Update Eject Change Password
CodeMeter is started. Webadmin

e

Click on License Update to bring up the CmFAS Assistant panel.

(@ cmFas Assistant B

Welcome to the CmFAS Assistant!

The CodeMeter Field Activation Service (CmFAS) assistant helps you adding,
changing and deleting licenses from the license management system CodeMeter.

With the CmFAS assistant you can create license request files, which you can send
to the producer of the software by email, You can also import the received license
update files with the CmFAS assistant into the license management and create a
receipt of the import for the producer.

< Back Next = ] [ Help

“ o

Select Next.
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& CmFAS Assistant 7| =

Please select the desired action

) Create license request

Choose this option if you want to create a license request file in order to send it
to the producer of the software.

) Import license update

Choose this option, if you received a license update file from the software
producer and want to import this file.

@ Create receipt

Choose this option if you want to confirm the successful import of a license
update fille for the software producer.

Click on Create receipt

’ < Back H Mext = l[ Help

Tick on Create receipt and then select Next.

. ™y
(& CmFAS Assistant PR

Please choose the producer

[¥]i12d.com (101956)

Tick on 12d.com

Select the software producer to which you want to send the receipt file. The
producer will only see the data which you select here. So you can ensure that the
producer doesn't see which other licenses from other suppliers you have.

[ < Back ][ Mext = ][ Help

L8

Tick on 12d.com and then select Next.

Page 118 Updating Licenses in Network CodeMeters
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& CmFAS Assistant 7| %

Please select the file name

C:f12d Jobs/2-2310278. WibuCmRaC

Select a file name for storing the receipt file file. Then dick on 'commi
file, You can then send this file to the producer by email.

Select the folder where the file is to be written to.

Leave the actual file name as it is.

Click on Commit

[ < Back Commit ][ Help ]

Select the file to use to update the CodeMeter and then select Commit.
Email the .WibuCmRacC file to your 712d Model Reseller.

Your 12d Model Reseller will then be able to send you a .WibuCmRaU file to update your
Network CodeMeter.

For information on how to use a .WibuCmRaU f file to update the CodeMeter, see 10.5.1.1
Updating Using the .WibuCmRaU File on page 120.
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10.5.1.1 Updating Using the .WibuCmRaU File

The number of virtual 72d dongles and the number of 72d Model licenses on them can be
changed electronically without having to remove the CodeMeter from the computer.

To update the CodeMeter, you will be sent a file starting with the CodeMeter number, then the
date and finally ending in .WibuCmRau.

The steps below will show how to use the .WibuCmRau file to update the Network CodeMeter

You need to have System Administrator rights to update the Network CodeMeter.

Before updating a Network CodeMeter dongle, run the CodeMeter WebAdmin software to
check that no one is using the Network CodeMeter (10.4 Monitoring and Cancelling Licenses on

page 102). The CodeMeter WebAdmin displays network dongle activity and it can also remove
users from the network dongle.

Once all the users are off the Network CodeMeter, double click on the file
codemeter_number_date.WibuCmRau and the following panel will appear:

WIBU-SYSTEMS Shell Extensicn l J

@% Do you want to transfer the file contents of

._9_. ChUsers\ljghAppDatat Local\Microsoft\Windows\ Temporary Internet
Files\Content. Outloold LPCZ6RTR2-2310247-2015-08-13(1).WibuCmRa
U into the suitable CmAct license?

Yes | Mo |

L% A

Select Yes and a panel to say how many CodeMeters have been updated should appear.

([ CrRmtActsd [ |

101 0 CmSticks successfully updated.

Click on OK -

L% 4

The CodeMeter should now be updated. The CodeMeter WebAdmin can be used to check that
the new number of licenses, or new number of 12d dongles, are now available.

WARNING: If there is no association for the .WibuCmRau file, double clicking on
the .WibuCmRau file won’t work. In that case go to 10.5.1.2 Manually Updating the Network
CodeMeter on page 121.

Nodes.4d:

If you've added a new virtual 12d dongle to your CodeMeter then a new nodes.4d file with that
12d dongle number in it will be needed. If all you did was change the number of licenses for an
existing 72d dongle in the Network CodeMeter then a new nodes.4d file is not required.



Chapter 10 CodeMeter Control Center & WebAdmin

10.5.1.2 Manually Updating the Network CodeMeter

If there is no association with the .WibuCmRau file then double clicking on the .WibuCmRau
file won’t automatically run the CodeMeter update program. So instead, the update will have to
be done manually using the CodeMeter Control Center panel.

The CodeMeter Control Center panel is accessed by clickingon —— g
the CodeMeter icon that was installed on your task bar.

(& CodeMeter Control Center g

License Events Borrow

@ Cm5Stick Name:

2-2310262
[2-2310242 ]

Serial: 2-2310262

Version: CmStick 2.04

@ [~

Capadity: 93 % free (367400 Bytes)

Click on License Status: @ () Dissbled
(2 (2 Enabled until unplugged

© (& Enabled
License Update Eject Change Password

CodeMeter is started. Webadmin

e 4

Click on License Update to bring up the CmFAS Assistant panel.

(@ cmFas Assistant [EER)

Welcome to the CmFAS Assistant!

The CodeMeter Field Activation Service (CmFAS) assistant helps you adding,
changing and deleting licenses from the license management system CodeMeter.

With the CmFAS assistant you can create license request files, which you can send
to the producer of the software by email, You can also import the received license
update files with the CmFAS assistant into the license management and create a
receipt of the import for the producer.

< Back Next = ][ Help

“ o

Select Next.
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.
(&) CmFAS Assistant

Please select the desired action
) Create license request

to the producer of the software,
@ Import license update

producer and want to import this file,

) Create receipt

update file for the software producer,

Click on Import license update

Choose this option if you want to create a license request file in order to send it

Choose this option, if you received a license update file from the software

Choose this option if you want to confirm the successful import of a license

[ < Back ][ Next = H

Help

L

Tick on Import license update and then Next.

(&) CmFAS Assistant

Please select the file name
C:f12d Jobs/2-2310247-2015-08-13. WibuCmRal

on "commit’ to import the new licenses.

Select the file to use to update the CodeMeter

\

Click on Commit

lect a file under which the license update file is stored on your computer. Then dick

[ < Back ][ Cormnmit ][

Help ]

"

Select the file to use to update the CodeMeter and then select on Commiit.

Nodes.4d:

If you've added a new virtual 12d dongle to your CodeMeter then a new nodes.4d file with that
12d dongle number in it will be needed. If all you did was change the number of licenses for an
existing 72d dongle in the Network CodeMeter then a new nodes.4d file is not required.

Note - if the CodeMeter that the file applies to is not on the computer then an Error message will
be brought up. See 10.5.2 Errors Updating the Network CodeMeter on page 123.

Page 122 Updating Licenses in Network CodeMeters
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10.5.2 Errors Updating the Network CodeMeter

If there was a problem, instead of the dialogue stating that the CodeMeter has been updated, a
CodeMeter error panel will appear. For example:

i ™
(& CodeMeter L&J
Error:
Update for CmDongle 2-2310247 Firmlterm 101956 --» Box not found

If you can’t work out what your error was, email the error message to your 72d Model Reseller.

Doing a Print Screen and saving the png or bmp is the best way to record details of the error and
send the image to your 72d Model Reseller.

icenses in Network CodeMeters Page 123
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10.6 Replacing an Existing Network CodeMeter

10.7

Before removing a Network CodeMeter, run the CodeMeter WebAdmin software to check that no
one is using the Network CodeMeter dongle (10.4 Monitoring and Cancelling Licenses on

page 102).

If there are no user on the Network CodeMeter, the existing Network CodeMeter can be removed
from the computer and the new Network CodeMeter attached.

The new Network CodeMeter should now be ready to use.

NOTE - a new nodes file will be required for the new virtual 12d dongles that are in the new
Network CodeMeter.

End of the Notes on Network CodeMeters

This ends the general notes on the Network CodeMeter.

However information on Certifying Network CodeMeters is covered in 8 Errors Installing and
Authorising on page 56.

If you need to install 72d Model on a computer, go to the section 2 Installing 12d Model 14
Release Version on page 6.

The links for downloading documentation on 72d Model are given in 6 Documentation on
page 47.

The links for downloading information, power points and videos on what is new in 712d Model 14
are given in 7 What's New in 12d Model 14 on page 55.
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10.8 Which Version of WebAdmin?

Clicking on the WebAdmin button brings up the CodeMeter WebAdmin panel which can display
information about 712d Model licenses for any CodeMeter (Network or Standalone) that is visible
on Servers in the computer network.

Depending on when the CodeMeter was installed on a particular Server, you can get different
versions of the WebAdmin pages.

If on a Server the WebAdmin Dashboard page looks like:

@& WebAdmin | Dashboard x

¢ @ @ localhost:22350/index.html - O In @ =
CodeMeter WebAdmin C In this case you need to follow
SYSTEWS instructions and images for
CodeMeter WebAdmin 6

DEEILLEIGE Container v License Monitoring v Diagnosis v Configuration v Info ~

@ Dashboard ® = engish(us) ~

Current Server: Docco

1P-Address: 151

Operating System:  Microsoft Windows 10 Enterprise, 64-Bit
Server Startup: 2018-11-18 05:35:43

Server Version: Version 6.30a of Jul/28/2016 (Build 2266)
Runtime Version: 6.30a

Current Server: localhost (127.0.0.1) & i WebAdmin Version: 6.30

Otherwise if the WebAdmin Home page on a Server looks like:

Index ‘ CodeMeter | WebAdmit X ‘ e
@ localhost:22350/Content.ntmZBoxSerial=3-3375053

CodeMeter WebAdmin ( |
LG content erver Configuration Diagnosis Info Help

CmcContainer Licenses User Data Backup/Restore

In this case you need to follow

CmContainer: . . .
Name: instructions and images for

— TRaTEE
CmContainer Type: CmStick 2.05 CodeMeter WebAdmin 5
First Device: No drive assigned (HID)
Status: D oisabled

Enabled until Unplugged
B enabled

System Time (FC): 2018-12-23 13:59:36

System Time (CmContainer): 2018-12-23 13:59:29
Certified Time (CmContainer): 2016-01-29 12:27:24 Update
Free Memory: 94 % (315.640 Bytes) | Defragment

Important Note:
It is possible to have different versions of WebAdmin installed on different Servers.

So depending on which Server you are looking at, you may need to swap between the notes
for WebAdmin 6 and WebAdmin 5.
For instructions on finding information about CodeMeters on a particular Network Server, see

10.4.1 Getting Info on CodeMeters on a Particular Server - WebAdmin 6 on page 103
10.4.3 Getting Info on CodeMeters on a Particular Server - WebAdmin 5 on page 110.

Which Version of WebAdmin? Page 125
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